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Preface

Intended Audience
This document is intended for IT professionals who are tasked with implementing 
Oracle Knowledge Management.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Knowledge Management

If you have never used Oracle Knowledge Management, Oracle suggests you 
attend one or more of the Oracle Knowledge Management training classes 
available through Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains information you will need to understand in order to 
implement Oracle Knowledge Management.

■ Chapter 1: Provides an overview of Oracle Knowledge Management as well as 
a listing of what’s new, what’s changed, and what’s obsolete in this release.

■ Chapter 2: Provides information on related documentation and training as well 
as an overview of the implementation dependencies.
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■ Chapter 3: Provides an overview of the various roles and business processes 
that are utilized in Oracle Knowledge Management. In addition, this chapter 
provides a listing of the steps necessary to implement Oracle Knowledge 
Management.

■ Chapter 4: Provides implementation steps for implementing Oracle Knowledge 
Management. In addition, this chapter contains a listing of implementation 
considerations and a listing of upgrade considerations.

■ Chapter 5: Provides a list of verification steps that should be used to validate 
the implementation.

■ Chapter 6: Provides an overview of the product integrations with Oracle 
Knowledge Management. In addition, this chapter provides a number of setup 
steps required to enable certain integration functionality.

■ Chapter 7: Provides information to help implementers diagnose and 
troubleshoot issues that they may experience during the implementation 
process.

Typographic Conventions
This manual uses the typographic conventions listed in the following table:

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 

Convention Meaning

italic text Book titles

Courier text User commands, file content examples, directory names

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and form options, emphasis

< > Angle brackets enclose user-supplied names. 

Note: Do not type the angle brackets.
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markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle Corporation does not own or control. Oracle Corporation neither 
evaluates nor makes any representations regarding the accessibility of these Web 
sites. 

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Knowledge Management.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle Knowledge Management shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Knowledge Management.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.
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If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Knowledge 
Management (and any other Oracle Applications products). This guide also 
includes information on setting user profiles, as well as running and reviewing 
reports and concurrent processes.

You can access this user’s guide online by choosing Getting Started with Oracle 
Applications from any Oracle Applications help file.

Documents Related to This Product

Installation and System Administration

Oracle Applications Concepts
Refer to this guide for an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
Refer to this guide for instructions on managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
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(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Oracle Applications Maintenance Procedures
Refer to this guide for information on configuring your system, maintaining your 
system, applying patches. You will also find information on migrating files and 
databases, reporting and tracking, and troubleshooting. 

Oracle Applications Maintenance Utilities
Refer to this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications CRM System Administrator’s Guide
Refer to this guide for information on implementing the Oracle CRM Technology 
Foundation (JTT).

Oracle Applications System Administrator’s Guide
Refer to this guide for planning and reference information for the Oracle 
Applications System Administrator. It contains information on how to define 
security, customize menus and online help, and manage concurrent processing.

Oracle Applications Developer’s Guide
Refer to this guide for the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
Refer to this guide for the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.
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Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
Refer to this guide if you use the Multiple Reporting Currencies feature to record 
transactions in more than one currency, use this manual before implementing 
Oracle Knowledge Management. This manual details additional steps and setup 
considerations for implementing Oracle Knowledge Management with this feature.

Multiple Organizations in Oracle Applications
Refer to this guide for descriptions of how to set up and use Oracle Knowledge 
Management with Oracle Applications' Multiple Organization support feature, so 
you can define and support different organization structures when running a single 
installation of Oracle Knowledge Management.

Oracle Alert User’s Guide
Refer to this guide for information on defining periodic and event alerts to monitor 
the status of your Oracle Applications data.

Oracle Workflow Guide
Refer to this guide for information on defining new workflow business processes as 
well as customizing existing Oracle Applications-embedded workflow 
processes.You also use this guide to complete the setup steps necessary for any 
Oracle Applications product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
Refer to this guide for flexfields planning, setup and reference information for the 
Oracle Knowledge Management implementation team, as well as for users 
responsible for the ongoing maintenance of Oracle Applications product data. This 
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
 eTechnical Reference Manuals (eTRMs) contain database diagrams and a detailed 
description of database tables, forms, reports, and programs for a specific Oracle 
Applications product. This information helps you convert data from your existing 
applications, integrate Oracle Applications data with non-Oracle applications, and 
write custom reports for Oracle Applications products. Oracle eTRM is available on 
Metalink
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Oracle Manufacturing APIs and Open Interfaces Manual
Refer to this manual for up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
Refer to this manual for up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
Refer to this manual for descriptions of Oracle Applications messages. This manual 
is available in HTML format on the documentation CD-ROM for Release 11i.

Oracle Common Application Components Implementation Guide
Refer to this guide to implement common application components leveraged by the 
CRM suite of products. These include Resource Manager, Notes, Spreadtable, 
Assignment Manager, Task Manager, Calendar, escalation Manager, Business Rule 
Monitor, and User Management. 

Oracle Common Application Components API Reference Guide 
Refer to this guide for information on the public APIs for Resource Manager, Task 
Manager, and Notes. 

Oracle Common Application Components User's Guide 
Refer to this guide for information on using the common application components 
leveraged by the CRM suite of products. These include Resource Manager, Notes, 
Spreadtable, Assignment Manager, Task Manager, Calendar, escalation Manager, 
Business Rule Monitor, and User Management. 

Oracle Knowledge Management and Related Product Documentation
In addition to the technology related guides listed above you can find a listing of 
documentation for Oracle Knowledge Management and the related products in 
Section 2.1, "Related Documentation and Training".
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Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Knowledge 
Management and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University's online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Knowledge 
Management working for you. This team includes your Technical Representative, 
Account Manager, and Oracle’s large staff of consultants and support specialists 
with expertise in your business area, managing an Oracle8i server, and your 
hardware and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Top Tech Docs/ERP Applications/Applications Installation and Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Top Tech Docs/ERP Applications/Applications 
Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, 
database triggers, or any other tool to modify Oracle Applications data unless otherwise 
instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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1
Introduction

This chapter provides an introduction to Oracle Knowledge Management. The 
sections in this chapter include:

■ Section 1.1, "Oracle Knowledge Management Overview"

■ Section 1.2, "Oracle Knowledge Management Key Features"

■ Section 1.3, "Oracle Knowledge Management Integrations"

■ Section 1.4, "New in this Release"

■ Section 1.5, "Changed in this Release"

■ Section 1.6, "Obsolete in This Release"

■ Section 1.7, "Oracle Knowledge Management System Requirements"

1.1 Oracle Knowledge Management Overview
Oracle Knowledge Management is an information management system that utilizes 
knowledge capture, storage, and distribution tools developed by Oracle. 
Implementing Oracle Knowledge Management provides the features of solution 
search, creation, organization, and immediate access to new solutions. Oracle 
Knowledge Management provides focused results that more directly relate to the 
issue being researched, thus reducing the cost of providing service while increasing 
customer satisfaction, and gaining an edge over competitors.

Oracle Knowledge Management currently provides solution management 
functionality to other Oracle Applications like Oracle iSupport, Oracle TeleService, 
Oracle Field Service, Oracle Depot Repair, and Oracle eMail Center. The architecture 
has been designed to support diverse use, and is expected to be used by other 
Oracle products.
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All Oracle Knowledge Management users can search for published solutions in the 
Knowledge Management repository. The users can be segregated as internal and 
external or end users. External users can view and search published solutions. 
Internal users include Customer Service Representatives (CSR), Knowledge 
Workers, and Knowledge Administrators. These users have various levels of setup 
and other process oriented permissions. To see the entire list of roles and 
permissions for internal users, navigate to Appendix A, "Oracle Knowledge 
Management Seed Data".

1.2 Oracle Knowledge Management Key Features
Oracle Knowledge Management includes the following features:

Integration With Other Oracle Applications
Oracle Knowledge Management is integrated with other Oracle Applications like 
Oracle iSupport, Oracle TeleService, Oracle Field Service, Oracle Depot Repair, and 
Oracle eMail Center. Users of all these applications can search the same knowledge 
base for solutions and contribute new solutions to the knowledge base.

Multiple Search Methods 
Oracle Knowledge Management can be configured so that users can choose a 
searching method. The search methods include All Keywords, Any Keywords, 
Fuzzy Match, Theme, Accumulate, Intermedia, and Reference Number. A query can 
consist of a single or multiple search terms, the latter separated by spaces.

Oracle Knowledge Management uses Oracle Text for text searching.

Product, Platform, or Category Specific Search of Solutions
To focus search results, you can search for solutions under different products, 
platforms, and/or categories.

Product and platform fields on the Advanced Search user interface allows a user to 
focus the search and obtain results that contain the specific product and/or 
platform as well as solutions that are generic for all products and/or platforms. 

Category selection allows a user to choose a category or a subcategory to focus the 
search to a specific information area more easily and quickly than adding additional 
query statements.
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Finding Matching Statements/Solutions
While creating a statement, you can find matching statements in the knowledge 
base to prevent duplication.

Finding Related Statements/Solutions
You can reuse statements in more than one solution. Finding related 
solutions/statements is the process of following the statement’s reused links to 
locate other related solutions/statements. 

Creating and Searching by Multiple Solution Types
Information in Oracle Knowledge Management is organized into solutions, that is a 
collection of statements. You can create multiple solution types to organize 
solutions. You can also search by either symptom/cause/action (default) solution 
type or any other solution type, such as problem/resolution, that you create.

Solution Authoring Features
Solution authoring functionality includes creating new solutions and updating 
existing solutions. Authors can also check solutions in and out of the knowledge 
base. For source control, only one internal user can edit a solution and/or statement 
at one time. An author can set up the access level for solutions and also create new 
solutions by reusing existing statements. The Oracle Knowledge Management 
system checks and prevents the creation of duplicate solutions or statements.

Categorization of Solutions 
In Oracle Knowledge Management, solutions are segregated in categories or folders 
for browsing or for performing a category specific search for solutions.

A merchant can categorize solutions for easy retrieval by its users. A user can 
choose a category or a subcategory during search to focus the search to a specific 
information area. 

Adding Attachments, External Links, and/or Comments to Solutions 
This feature allows Knowledge Workers, Knowledge Administrators, and Customer 
Service Representatives (internal users) to add supporting and related information, 
links to other objects to a solution to enhance its usefulness. 

Comments are used by solution reviewers as a communication channel.
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Solution Scoring
Each solution is scored based on the text match performed by Oracle Text. The 
maximum score is 100. Solution scores vary depending on the search method being 
used.

1.3 Oracle Knowledge Management Integrations
Oracle Knowledge Management integrates with the following Oracle Applications:

■ Oracle TeleService

■ Oracle Depot Repair

■ Oracle Field Service

■ Oracle iSupport

■ Oracle eMail Center

■ Oracle Quality Online

■ Oracle Partners Online

For information on how these products integrate with Oracle Knowledge 
Management, refer to Chapter 6, "Oracle Knowledge Management Integrations".
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1.4 New in this Release
This section details what is new in this release.

1.4.1 New Features/Functions
The following new features/functionality have been added in this release of Oracle 
Knowledge Management:

Unified Search (within Basic Search)
In this release the unified search functionality within the Basic Search pages enables 
searching across multiple repositories using key words. The unified searching 
functionality will search across Solutions and Forums and has the ability to cover 
additional repositories with further setup by the administrator.

Also, a new profile option called Default Searching Method sets the default 
searching method for the user. This default search method also controls the 
searching method for all search repositories in Basic Search that leverages 
Intermedia search.

Hide Platform Section
A new profile option has been created to allow the administrator to hide the 
Platform section throughout the application.

If the platform is hidden, it is hidden from View Solution, Advanced Search, and 
Create/Update Solution pages. All solutions updated afterward will have the 
platform attributes removed if they initially had any platform attributes.

Enabling/Disabling Authoring Flows
You can now enable or disable the authoring flows that have been created. 

Viewing the In-Progress Version of a Solution
When viewing the published solution (from Search), you can, with relevant 
permission, switch to view the in-progress version if the solution is being edited.

Guest User Support
The Guest User concept allows unregistered or registered users to access certain 
features without having to log in.
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A Guest User is a user who comes to the site and does not log in explicitly, but 
implicitly to the applications to use certain functionality. The Knowledge 
Management Guest User will be able to use the following pages at specified 
locations (URLs) without explicitly logging in to the applications:

■ Basic Search and Browsing Pages

■ Search Result Pages

■ View Solutions Detail page

When a normal user has not logged in to the applications but uses the URL to open 
any of the above pages, the application will render the page in guest user mode, 
with the login icon. Users can log in to see pages for their respective role and 
permissions.

Refer to the Oracle iSupport User Guide for more information.

User Interface Configuration
You can now configure the Browser, Search Results, and Solution Detail pages in 
Oracle Knowledge Management using the Oracle iSupport interface. For more 
information, refer to the section Section 4.8.4, "Functions for Configuring Oracle 
iSupport Pages", and also to About Oracle iSupport in Oracle Service Family Pack I.

1.4.2 New Profile Options
The following new profile options have been added in this release. For a complete 
description of the Oracle Knowledge Management Profile Options refer to 
Table B–1, "Profile Options for Oracle Knowledge Management":     

Note: Guest User support in Oracle Knowledge Management is 
made possible through the Oracle iSupport interface.

Table 1–1 New Profile Options

User_Profile_Option_Name

Knowledge: Select Authoring Flow

Knowledge: Concurrent Search Mode for Unified Search

Knowledge: Default Distribution Level (CS_KB_DEFAULT_ACCESS_LEVEL)

Knowledge: Default Authoring Flow
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1.5  Changed in this Release
This section details what has changed in this release.

1.5.1 Changed Features/Functions
The following features/functionality have been changed in this release of Oracle 
Knowledge Management:

Search Results in Basic and Advanced Search for Solutions
Solution search results in Basic and Advanced Search has been refined to show only 
solutions that have been published. For solutions that are being edited, the 
published version is presented.

Improved Usability for Browsing Categories
Oracle Knowledge Management now presents an improved user interface for 
solution browsing. Bread crumb navigation allows improved navigation to and 
from previous pages. 

Common View Solution Detail Page
The presentation and format of the View Solution page now appears consistent 
whenever a knowledge solution is viewed within Oracle Knowledge Management 
or called from Oracle iSupport, Oracle TeleService, or Oracle Depot Repair.

Knowledge: Display QuickFind

Knowledge: Default Search Relevancy

Knowledge: Available Repositories for Search

Knowledge: Display Search Option List

Knowledge: Expose Search Related Solutions Button

Knowledge: Default Searching Method

Knowledge: Display Platform Attributes

Knowledge: Default Solution Type for Authoring

Table 1–1 New Profile Options

User_Profile_Option_Name
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Enhanced Solution Advanced Search Page
The user interface for Advanced Search has been streamlined to provide a better 
layout and interaction of components. Searching similar and related Statements 
using the Advanced Search has also been enhanced.

Display of Solutions Using Advanced Search
A new profile option (Knowledge: Expose Search Related Solutions Button) allows 
you to search only for Related solutions. If this profile is turned off, when 
performing an advanced search, the system returns both Matching and Related 
solutions for the selected search statements combined into a single search result list.

The Statement Detail Page
The Statement Detail for Solution page has been refined to provide a better layout 
and presentation of information.

Improved Solution Submission to Authoring Flows
The solution authoring process has been revised. A new profile option (Knowledge: 
Select Authoring Flow) has been created for the administrator to select a default 
authoring flow. Solutions are submitted directly to the default flow if the default 
flow is set up, and the profile option Knowledge: Select Authoring Flow is turned 
off. This solution submission enhancement simplifies the solution contribution 
process for users, who are not knowledge workers, when they want to contribute 
solutions to the knowledge base.

If the profile, Knowledge: Select Authoring Flow, has been turned on, and you 
submit a solution, a list of all the available flows is displayed from which to choose. 
These usability improvements apply to the process in which solutions are:

■ Initially submitted to an authoring flow

■ Re-submitted to an authoring flow

Note: The Solution Advanced Search was previously named 
Advanced Search.

Note: When you submit a solution to an authoring flow, it is 
submitted to the first step of the flow.
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The Create/Update Solution Detail Page
The Create/Update Solution Detail page has been revised to provide you with a 
consistent application look and feel, flow, page layout, and component interaction. 
The error handling and duplication checking of solutions and statements during the 
create/update solution process has also been improved. When you now try to 
create a new statement, an automatic search takes place to make sure that the 
statement does not already exist. If the statement already exists, the existing 
statement automatically replaces the new statement just entered.

Solutions in Progress
Knowledge Workers can now easily find and manage solutions by using Table 
Views of solutions in progress. These views include:

■ Solutions I’m currently working on: The solutions you are currently working on 
and/or the solutions you have checked out for editing.

■ Solutions in progress I can check out for editing: The solutions you are eligible 
to work on (check out).

■ All solutions in progress: All the solutions in progress.

Additionally, improvements have been made to the Solution in Progress Search 
page available from the Solution in Progress subtab. If you cannot find the desired 
solutions in progress through one of the views mentioned above, the Search 
Solutions in Progress page with updated search options can be used to find the 
solutions.

End Dating Solution and Statement Types
The knowledge administrator can now end date solution and statement types. End 
dating a statement or solution type will prevent any further statements or solutions 
of this type from being created. Solutions or statements currently in progress will be 
allowed to complete.

Such functionality allows you to maintain the knowledge base over time by 
performing general housekeeping on solutions and statements types. End dating a 
solution or statement type does not mean that the solution or statement type has 
been deleted. Instead, it is considered a soft delete that can be revoked by removing 
the end date on the solution or statement type at any point in time.



Changed in this Release

1-10 Oracle Knowledge Management Implementation Guide                              

1.5.2 Changed Pages
With this release the Oracle Knowledge Management user interface has undergone 
considerable usability and presentation enhancements. This is in keeping with 
Oracle's Browser Look and Feel standards.

The result is a modification to screens for all Oracle Knowledge Management user 
types. The few major changes in the user interface including renamed tabs and 
subtabs are listed in Section 1.5.5, "Changed Menus".

1.5.3 Changed Profile Options
The following profile options have changed in this release. For a complete 
description of the Oracle Knowledge Management Profile Options refer to 
Table B–1, "Profile Options for Oracle Knowledge Management":

1.5.4 Changed Concurrent Programs
The Knowledge Management Index Synchronization Program has been changed to 
synchronize the new forum index within Oracle Text.

1.5.5 Changed Menus
The following tabs/subtabs in Oracle Knowledge Management have been renamed:

Table 1–2 Changed Profile Options

New User_Profile_Option_Name Former User_Profile_Option_Name

Knowledge: Maximum Number of Search 
Results

Knowledge: Knowledge Base Search: 
Maximum Number of Search Results.

Knowledge: Event handler class name for a 
calling application

Knowledge: Event Handler class name for 
KM solved/unsolved actions predefined 
by other apps

Knowledge: Default Product Category Set Knowledge: Default Knowledge Base 
Product Category Set

Knowledge: Default Solution Type for 
Authoring

Knowledge: Default Solution Type

Knowledge: User Responsibility when 
Calling KM from Another Application

Knowledge: Knowledge Base 
Responsibility when Called from Another 
Application
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1.5.6 Changed Responsibilities
You can now access Oracle Knowledge Management from an HTML login screen or 
a PHP login screen. With this release, the Available from Setting has been changed 
from Oracle Applications to Oracle Self Service Web Applications for the following 
responsibilities:

■ Knowledge Administrator

■ Knowledge Agent

■ Knowledge Worker

1.6 Obsolete in This Release
This section details what is obsolete in this release.

1.6.1 Obsolete Profile Options
The following profile options are obsolete in this release.

Former Release Tab Name Current Release Tab Name

Search Knowledge

Basic Search Knowledge

Statement Search Statements

Work Pending Solutions in Progress

Table 1–3 Obsolete Profile Options

Profile Options

Knowledge: Default Authoring Flow Name

Knowledge: Default Distribution Level (CS_KB_SMP_SOL_ACCESS_LEVEL) 

Knowledge: Default Statement Content Type

Knowledge: Default Solution Priority
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1.7 Oracle Knowledge Management System Requirements
The hardware and software components required to implement Oracle Knowledge 
Management largely depend on your particular installation. For information on 
system requirements refer to the Installing Oracle Applications manual and the Oracle 
Applications CRM System Administrator’s Guide. 
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2
Before You Begin

This chapter describes resources and dependencies that you will need to be familiar 
with before you implement Oracle Knowledge Management. The sections in this 
chapter include:

■ Section 2.1, "Related Documentation and Training"

■ Section 2.2, "Oracle Knowledge Management Dependencies"

■ Section 2.3, "Installation and Dependency Verification"

2.1 Related Documentation and Training
In addition to the technology related guides listed within the "Other Information 
Sources" section of the Preface, the following guides provide information about 
Oracle Knowledge Management and the products that integrate with Oracle 
Knowledge Management:

■ Oracle Knowledge Management User Guide

■ Oracle iSupport User Guide

■ Oracle iSupport Implementation Guide

■ Oracle TeleService User Guide

■ Oracle TeleService Implementation Guide

■ Oracle eMail Center User Guide

■ Oracle eMail Center Implementation Guide

■ Oracle Depot Repair User Guide

■ Oracle Depot Repair Implementation Guide
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■ Oracle Quality Online User Guide

■ Oracle Quality Online Implementation Guide

■ Oracle Field Service User Guide

■ Oracle Field Service Implementation Guide

For information on how these products integrate with Oracle Knowledge 
Management, refer to Chapter 6, "Oracle Knowledge Management Integrations".

2.2 Oracle Knowledge Management Dependencies
This section describes mandatory and optional dependencies for Oracle Knowledge 
Management.

2.2.1 Mandatory Dependencies
Oracle Knowledge Management integrates with other Oracle application modules 
to provide and extend its functionality. In order for Oracle Knowledge Management 
to run you will need to set up the following mandatory applications/modules:

1. Access Application

2. Oracle Application Object Library

3. Oracle CRM Technology Foundation

4. Oracle Text

5. Oracle Human Resources

6. Oracle Common Application Components 

a. Task Manager 

b. Resource Manager

Access Application
Oracle Knowledge Management is not a stand alone application. Users can access 
Oracle Knowledge Management from any of the following applications:

■ Oracle Depot Repair

■ Oracle eMail Center

■ Oracle Field Service
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■ Oracle iSupport

■ Oracle Partners Online (from the Support tab in iSupport)

■ Oracle Quality Online

■ Oracle TeleService (from the Support module)

Oracle Application Object Library
Oracle Application Object Library (AOL) is a collection of pre–built application 
components and facilities for building and adding extensions to Oracle 
Applications. It is a required dependency of all Oracle Application modules. Oracle 
Knowledge Management uses AOL to access all standard application library objects 
e.g, users, menus, responsibilities, and profile options. For more information, see 
the latest version of Oracle Applications Developer’s Guide.

Oracle CRM Technology Foundation
Oracle CRM Technology Foundation (JTT) provides Java-based infrastructure 
software that is used to develop e-business solutions such as Sales, Marketing, 
Service, E-Commerce, Contracts, and Interaction Center applications. It offers a 
common platform for developing applications with HTML, XML, and Java. CRM 
Technology Foundation also provides user-friendly screens for centralized setup 
and administration. This web-based interface is called the System Administrator 
Console. The CRM User Management Framework documentation can be found 
within the documentation for this group. 

Setting Up Oracle CRM Technology Foundation Profile Options
Confirm the setup of the CRM Technology Foundation (JTT) profile options. Refer 
to the latest version of Oracle Applications CRM Administrator’s Guide for more 
information. The CRM Technology Foundation stack is also known as the HTML 
Stack or Tech Stack.

Oracle Text
You must set up Oracle Text (formerly known as Oracle InterMedia Text) to use 
Oracle Knowledge Management’s search functionality. 

Oracle Text provides integrated management of free text stored in the database, on 
websites, or on file systems. It extends the Oracle SQL query language to provide 
content-based search and to retrieve information from formatted documents and 
free text. This allows you to access a number of advanced text search capabilities 
from any SQL tool or interface.



Oracle Knowledge Management Dependencies

2-4 Oracle Knowledge Management Implementation Guide                             

For more information about Oracle Text, navigate to:

■ http://otn.oracle.com/products/text/content.html 

Oracle Human Resources
Oracle Knowledge Management uses Oracle Human Resources to get employee 
data. Define or confirm the definitions of your employees in Oracle Human 
Resources Management System. Refer to the Oracle Human Resources Management 
System documentation for more information:

■  Implementing Oracle HRMS

■  Using Oracle HRMS - The Fundamentals

■  Managing Your Workforce Using Oracle HRMS

■  Customizing, Reporting and System Administration in Oracle HRMS

■  Managing Total Compensation Using Oracle HRMS

Oracle Common Application Components
Oracle Knowledge Management leverages the following Oracle Common 
Application Components (formerly referred to as CRM Application Foundation):

■ Task Manager

■ Resource Manager

Task Manager
All Oracle CRM products use Task Manager for task management capabilities. It 
provides an effective way for organizations to respond to customer’s needs in time. 
Use the Task Manager to create, assign, schedule, prioritize, and manage all your 
tasks. You can access the Task Manager to create your tasks or to view your tasks. It 
can be used from other Oracle modules to provide integrated solutions or it can be 
used as a stand-alone product. 

If you refuse a task or reassign a task to another employee, the task can generate a 
series of notifications for other users or managers. Tasks not performed in a specific 
time period can be set to go through an escalation process. 

Refer to the Oracle Common Application Components Implementation Guide for more 
information.
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Resource Manager
Resource Manager is used in Oracle Knowledge Management to set up the various 
resource groups for authoring flows. The Resource Manager provides lists of 
resources, as individuals, groups, and teams, for applications to access and manage 
their resources. Resources are defined as employees, supplier contacts, parties, and 
partners that are used by the different CRM modules to accomplish business 
objectives. You can use Resource Manager to import and view resources, define 
resources, define roles and role types, create teams and groups, and organize 
resources within those teams and groups. Defining and organizing your resource 
information makes your resources available to the connected application modules 
for work action. Resources can be organized into groups and teams. Each group or 
team can be defined in one of two ways, a role, or a role type. 

Refer to the Oracle Common Application Components Implementation Guide for more 
information.

2.2.2 Conditional Dependencies
The following Oracle E-Business Suite modules can be set up to provide additional 
functionality:

1. Notes (Oracle Common Application Components)

2. Oracle Workflow

3. Oracle Inventory   

Notes
The Notes module is used in Oracle Knowledge Management to map statement 
types to note types. The Notes module enables the entire CRM suite to create, 
maintain, and share notes related to customers, opportunities, service requests, and 
other business tasks. The Notes module allows you to capture extensive textual, 
project relevant information within Oracle CRM applications. Notes module is 
seeded with predefined Note Types. 

Refer to the Oracle Common Application Components Implementation Guide for more 
information.

Oracle Workflow
Oracle Workflow allows you to automate and continuously improve business 
processes by routing information of any type, according to easily changed business 
rules, to people both inside and outside your enterprise. Refer to the Oracle 
Workflow Guide for more information.
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Oracle Workflow provides a workflow process to Oracle Knowledge Management 
for solution approval and rejection processes. It is a flexible method for Oracle 
Knowledge Management system administrators to define solution processing steps 
that are specific to their needs.

Oracle Inventory
Oracle Knowledge Management uses Oracle Inventory to get the product and 
platform lists that are used to categorize solutions during solution search or 
solution creation. For more information on Oracle Inventory, refer to the Oracle 
Inventory User’s Guide.

The following profile options have to be set for selecting product and platform 
items from Inventory:

■ Knowledge: Default Product Category Set

■ Service: Default Platform Category Set

2.2.3 Dependency Setup Checklist
The following table provides a suggested order for setting up the Oracle Knowledge 
Management dependencies. You must perform the required steps. The optional 
steps are may be necessary if you plan to use the related features or complete 
certain business functions.

Table 2–1 Dependency Setup Checklist

Step Required/Optional

Install Software Required

Set Up Oracle Application Object Library Required

Set up Oracle Human Resources Required

Set Up Oracle Inventory Optional

Set Up Oracle Workflow Optional

Set Up Oracle Text Required

Set Up an Access Application Required

Set Up Oracle CRM Technology Foundation Required

Set Up Task Manager Required

Set Profile Options for Oracle Knowledge Management Required
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Accessing Oracle Forms
Some setups for Oracle Knowledge Management and its dependencies require that 
you use Oracle Forms. Launch Oracle Forms by navigating to:

http://<host>:<apache port>/

Select Apps Logon Links > VIS Logon through the Forms cartridge. When Oracle 
Forms launches, log in with the appropriate user name and responsibility to 
perform the required tasks.

2.3 Installation and Dependency Verification
Before you start configuring the profile options and search for solutions or create 
solutions in Oracle Knowledge Management, check that you have completed the 
following prerequisites.

1. Verify that the installation and middle tier setups have been done correctly. 
Once the Rapid Installer Wizard finishes the installation, verify the proper 
installation and configuration of the following components:

■  Apache Server: Go to http://<host>:<apache port>/apachedocs/. You should see 
the Apache Server documentation page.

■  Apache JServ: Go to http://<host>:<apache port>/servlets/IsItWorking.

You should see a message verifying that Apache JServ is working.

2. Verify that the ERP applications are installed and functioning properly. Refer to 
the latest version of Implementing Oracle CRM: ERP Functional Checklist, Release 
11i document available on Oracle MetaLink for a description of the tasks 
required. 

3. Verify that the dependency setup has been done correctly. 

Set Up Oracle Knowledge Management Required

Table 2–1 Dependency Setup Checklist

Step Required/Optional
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3
Implementation Overview

This chapter provides an overview of how Oracle Knowledge Management is 
accessed, the associated job roles and process flows, and also provides a summary 
of the implementation tasks. The sections in this chapter include:

■ Responsibilities, Menus, and Tabs

■ Job Roles and Process Flows

■ Implementation Tasks

3.1 Responsibilities, Menus, and Tabs
Oracle Knowledge Management allows users that are internal to the company, such 
as Knowledge Workers and Customer Service Agents, as well as users that are 
external to the company, such as customers. All users can search for published 
solutions in the Oracle Knowledge Management repository. Each type of user in 
Oracle Knowledge Management has a defined set of permissions.

Roles determine screen-level permissions and reflect a user, such as a Knowledge 
Worker.   Roles are made up of permissions which control viewing a page, 
displaying a section/region within a page, and can even control button displays.   
Responsibilities control the menus that a user will be able to view. 

■ External users are End Users who only have view and search access to 
published solutions, such as customers. 

■ Internal users are employees and they include Customer Service Agents, 
Knowledge Workers, and Knowledge Administrators. 

The following table lists responsibilities, menus, and tabs associated with internal 
Knowledge Management users
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Table 3–1 Responsibilities, Menus, Tabs and Subtabs for Internal Knowledge 
Management Users

Responsibility
Functional 
Role Description Menus Tabs Subtabs

CS_KB_
KNOWLEDGE
_WORKER

Knowledge 
Worker

Creates, edits, 
and 
technically 
reviews 
information in 
Knowledge 
Management

CS_KB_TOP_
KW_MENU

Knowledge, 
Authoring

Knowledge, 
Statements, 
Create 
Solution, 
Solutions in 
Progress, 
Top 
Solutions 

CS_KB_
AGENT

Customer 
Service Agent

Interfaces 
with 
customers to 
record their 
problems and 
provides them 
existing 
solutions or 
creates new 
solutions

CS_KB_TOP_
AG_MENU

Knowledge, 
Authoring

Knowledge, 
Create 
Solution, 
Solutions in 
Progress, 

CS_KB_SYS_
ADMIN

Knowledge 
Administrator

An 
administrator 
with all 
Knowledge 
Management 
specific 
permissions 
including 
setup and 
other process 
oriented 
permissions

CS_KB_TOP_
MENU

Knowledge, 
Authoring, 
and Setup

Knowledge, 
Statements, 
Create 
Solution, 
Solutions in 
Progress, 
Top 
Solutions, 
Solution 
Types, 
Statement 
Types, 
Create 
Type, 
Categories, 
Authoring 
Flows, 
Frequently 
Used 
Definitions 
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3.2 Job Roles and Process Flows
The following process flows are designed to provide you with a general, high-level 
understanding of the tasks that Knowledge Administrators, Knowledge Workers, 
and End Users perform within Oracle Knowledge Management. For detailed 
information on performing these tasks within the application refer to the Oracle 
Knowledge Management User Guide.

Table 3–2, "Job Roles and Process Flows Matrix" provides a cross reference of the 
process flows and the associated job roles. 

Table 3–2 Job Roles and Process Flows Matrix

Note: Customer Service Agents perform many of the same tasks 
in Oracle Knowledge Management as Knowledge Workers, but will 
typically have a more limited scope in the Solution Authoring 
process.

Process Flows

Knowledge 
Administrator 
Flows

Knowledge 
Worker 
Flows

Customer 
Service 
Agent

End 
User 
Flows

Creating Authoring Flows YES NO NO NO

Managing the Knowledge Base 
Structure

YES NO NO NO

Creating Top Solutions for 
Oracle iSupport Users

YES YES NO NO

Authoring a Solution NO YES YES NO

Review Solutions in Progress YES YES NO NO

Updating an Existing Solution NO YES YES NO

Searching the Knowledge Base

Conducting a Basic Search 
(also known as a Unified 
Search)

YES YES YES YES

Browsing Solution 
Categories

YES YES YES YES
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3.2.1 Knowledge Administrator Flows
The primary functions that Knowledge Administrators perform within Oracle 
Knowledge Management are as follows:

■ Manage the Knowledge Base Structure

■ Create Authoring Flows

■ Set Up Top Solutions for iSupport Users

The following flows provide a graphical representation of these processes.

Managing the Knowledge Base Structure
The knowledge base structure provides the basis for partitioning information 
within the knowledge base. Its main components are Solution Types, Statement 
Types, and Solution Categories. The following flows provide a graphical 
representation of the tasks associated with setting up the knowledge base structure.

Conducting an Advanced 
Search

YES YES YES NO

Searching for Statements YES YES NO NO

Viewing Top Solutions in Oracle 
iSupport

NO YES YES YES

Note: Knowledge Administrators also perform some of the 
processes associated in this chapter with Knowledge Workers and 
End Users. Refer to Section 3–2, "Job Roles and Process Flows 
Matrix" for a more complete listing of the tasks that a Knowledge 
Administrator may perform.

The flows listed in this section are primary responsibilities of the 
Knowledge Administrator.

Process Flows

Knowledge 
Administrator 
Flows

Knowledge 
Worker 
Flows

Customer 
Service 
Agent

End 
User 
Flows
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Setting Up Solution Types and Statement Types
Solution Types and Statement Types provide a structure for organizing the type of 
information that comprises solutions and statements within the knowledge base.

Figure 3–1 Setting Up the Solution Types and Statement Types

Although Solution Types and Statement Types are created separately they are 
interrelated and should be designed in conjunction with one another:

■ Design Solution Types: Determine the number of Solution Types and the 
Statement Types that each Solution Type will include.

■ Design Statement Types: Determine the number of Statement Types and a 
description of the content that will comprise the Statement Type.

Note: Designing the knowledge base structure is a very important 
aspect of implementing Oracle Knowledge Management. Once 
Solutions have been added to the Solution Categories it is difficult 
to change the knowledge base structure.
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Once the Knowledge Administrator designs the Solution Types and Statement 
Types he will need to create the actual structures:

■ Create Solution Types: Add Solution Types to knowledge base. You must 
associate at least one Statement Type to a Solution Type.

■ Create Statement Types: Add Statement Types to the knowledge base.

In order to manage the knowledge base Knowledge Administrators will also need 
to know how to do the following:

■ Delete a Solution Types: Delete a Solution Type from the knowledge base. You 
cannot delete a Solution Type if there are solutions associated with the Solution 
Type.

■ Delete a Statement Types: Delete a Statement Type from the knowledge base. 
You cannot delete a Statement Type that is associated with a solution in the 
knowledge base.

Setting Up Solution Categories
Solution Categories are essentially folders that can be used to sort solutions into 
logical groupings.

Note: Solution Types and Statement Types are interrelated. 
Deleting these structures is not a common task in managing the 
knowledge base.

Solutions Types can be end dated when they are obsolete or no 
longer valid. End dating the type will take effect on the date 
specified by the Knowledge Administrator. Once the type has been 
end dated, no new solutions of that type can be created. however, 
solutions of that type will remain in the knowledge base, and can 
be searched and edited.

Statement Types can be end dated when an associated Solution 
Type is end dated. The Statement Type may not be end dated if 
there are relationships with other Solution Types that are still valid.

Once a Solution Type or Statement Type has been end dated, you 
cannot use that type in your search criteria. 
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Figure 3–2 Setting Up Solution Categories

■ Design Solution Categories: Determine how many solution categories and the 
names of the solution categories.

■ Create Solution Categories: Create Solution Categories.

■ Delete a Solution Categories: Delete a Solution Category from the knowledge 
base. You cannot delete a Solution Category that has an associated solution.

Creating Authoring Flows
Authoring Flows are used to automate the review and publication of solutions 
within the knowledge base. The following is a graphical representation of the 
process used to create authoring flows:

Figure 3–3 Create Authoring Flows 

To create an authoring flow knowledge administrators perform the following tasks: 
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■ Create resource groups: Create groups of users that can be assigned to a steps 
within the authoring flow process. For example, create a group called Editorial 
Reviewers, responsible for performing editorial reviews of solutions. 

■ Design authoring flow: Design the number of steps, their order within the 
authoring flow, the resource group associated with each step, and the action 
following each step. 

Before designing an authoring flow, it is important to understand which review 
steps and actions you can choose from.

■ Select step for authoring flow: Add steps to the authoring flow, for example, 
Editorial Review.

■ Assign action to step: Assign an action to the step, for example Publish.

■ Assign resource group to step: Assign the group that is responsible for 
performing a particular step within the authoring flow.

■ Select additional step: Add as many steps as you need to construct the 
authoring flow.

Creating Top Solutions for Oracle iSupport Users
Knowledge Administrators can mark certain solutions as’ Recommended’. 
Recommended Solutions are a list of solutions that are recommended for end users 
to view. Solutions included on this list might include fixes for a recently discovered 
product issue. Users navigating to the Top Solutions subtab in Oracle iSupport can 
view a listing of Recommended Solutions as well as a list of Frequently Used 
Solutions.   Frequently Used Solutions is a separate list of solutions based on usage 
counts. 

The following is a graphical representation of the tasks that a Knowledge 
Administrator must perform to manage the lists within the Top Solutions subtab. 

Top Solutions: Recommended Solutions List
The Recommended Solutions list is a list of solutions selected by the Knowledge 
Administrator to display in Oracle iSupport.

Note: Adding Recommended Solutions is often performed by a 
Knowledge Worker and not a Knowledge Administrator.
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Figure 3–4 Creating Recommended Solutions for Oracle iSupport Users 

■ Identify solutions to use for Recommended Solutions list: Identify how many 
and which solutions to include on the Recommended Solutions list. This may 
involve working with Knowledge Workers to determine the solutions that will 
be most useful to users.

■ Determine solution order for Recommended Solutions list: Determine what 
order the solutions will display in Oracle iSupport.

■ Add solutions to the Recommended Solutions list: Add the solutions to the 
Recommended Solutions lists. The list is set up in Oracle Knowledge 
Management and displayed in Oracle iSupport.

■ Delete Solutions from the Recommended Solutions list: Delete solutions as part 
of an ongoing maintenance of the Recommended Solutions list.

Top Solutions: Frequently Used Solutions List
The Frequently Used Solutions list is based on usage counts. Although there is a 
default view in Oracle iSupport, the view for these counts can be changed by 
selecting a new date range from a drop down list. These date ranges or definitions 
are created within Oracle Knowledge Management. In addition, the default view or 
date range is also set in Oracle Knowledge Management.

Figure 3–5 Defining Definitions for Frequently Used Solutions for Oracle iSupport 
Users
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■ Define definitions for Frequently Used Solutions: Create date ranges such as, 
within the last year, for display in the Frequently Used Solutions drop down list 
that displays in Oracle iSupport. This drop down controls the date range of the 
frequently used solutions that are displayed. 

■ Set default view for Frequently Used Solutions: Select the date range or 
definition that you would like to use as the default view for the Frequently 
Used Solutions list in Oracle iSupport.

3.2.2 Knowledge Worker Flows
The primary functions that Knowledge Workers perform within Oracle Knowledge 
Management are as follows:

■ Author solutions

■ Review solutions

■ Update existing solutions

■ Search the knowledge base

The following flows provide a graphical representation of these processes.

Authoring a Solution
Solutions are the cornerstone of the knowledge base and Knowledge Workers are 
generally responsible for managing content within the knowledge base. The 
following is a graphical representation of the tasks associated with creating a 
solution.

Figure 3–6 Authoring a Solution

Note: Knowledge Workers also perform some of the processes 
associated in this chapter with Knowledge Administrators and End 
Users. Refer to Section 3–2, "Job Roles and Process Flows Matrix" 
for a more complete listing of the tasks that a Knowledge Worker 
may perform.

The flows listed in this section are the primary responsibilities of 
the Knowledge Worker.
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Solution authoring involves the following tasks:

■ Formulate ideas: Determine the solutions that need to be created.

■ Draft/Edit solution: Write solution content and assign associated attributes to 
create a solution within Oracle Knowledge Management. You can review 
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solutions that you are currently working on and have saved from the Solutions 
in Progress page.

■ Save and work on later: Save the solution so that you may work on it later. 

■ Save and submit solution to authoring flow: Save changes and submit the 
solutions to a step/status in the authoring flow, for example, Publish. 

■ Select an authoring flow: Submit the solution to an authoring flow where it is 
reviewed and edited.

■ Receive confirmation/begin review process: Review confirmation that the 
solution has been submitted to a step within one of the Authoring Flows. You 
can review the status of the solution on this confirmation page. For example, if 
you submit the solution back to the initial draft or authoring step in an 
Authoring Flow the status will indicate that the solution has been ’Rejected to 
Author’.

■ Is the solution approved?: Track whether solution is approved at each step of 
the authoring flow.

■ Solution is approved and published: Solution is approved at each step of the 
authoring flow. This is done by a members of the Resource Groups that have 
been assigned to each step in the authoring flow. The Resource Group assigned 
to the step before Publish can determine when a solution is ready for 
publishing.

■ Solution is rejected: Solution is rejected back to author for modification. The 
solution will need to be saved and submitted again.

Review Solutions in Progress
One of the critical responsibilities of a Knowledge Worker is authoring and 
reviewing solutions. The following is a graphical representation of the tasks 
associated with reviewing a solution.

Note: Knowledge Workers may also need to obsolete a solution in 
the knowledge base during the solution lifecycle. 
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Figure 3–7 Reviewing Solutions in Progress
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Reviewing a solution involves the following tasks

■ Review solutions in progress: Review the Solutions in Progress subtab for a 
listing of solutions that are currently being authored. Views include Solutions 
that I am currently working on, Solutions that I can check out for editing, and 
All solutions in progress.

■ Is this my solution: Determine if this is a solution that you have drafted or 
checked out. You can view the solutions you are currently working on by 
selecting the ’View solutions that I’m currently working on’ view from the 
Solutions in Progress page.

■ Work on my solution: Modify or update a solution on which you are currently 
working.

■ Can I check this solution out: Determine whether you have proper permissions 
and whether you can approve the solution that someone else has authored.

■ Add comments to solution for reviewers: If you cannot check out the solution 
you can add comments for viewing by other reviewers. These comments will 
not be published.

■ Check out solution: Check out the solution for editing. This will lock the 
solution, so that no other Knowledge Workers will be able to check out the 
solution while you have it checked out.

■ Edit solution: Modify the solution. You will need sufficient permissions to edit a 
solution.

■ Save and work on later: Save the solution so that you may work on it later. 

■ Save and submit solution to authoring flow: Save changes and submit the 
solutions to a step/status in the authoring flow, for example, Publish. This step 
effectively checks the solution back in so that other Knowledge Workers can 
check out the solution.

Note: You can also add comments to a solution that you are 
editing.
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■ Change Authoring Flow: Determine whether you want to submit the solution 
to a new Authoring Flow.

■ Select step in Authoring Flow: Select a step/status in the authoring flow, for 
example, Publish.

■ Receive confirmation: Review confirmation that the solution has been 
submitted to a step within one of the Authoring Flows. You can review the 
status of the solution on this confirmation page. For example, if you submit the 
solution back to the initial draft or authoring step in an Authoring Flow the 
status will indicate that the solution has been ’Rejected to Author’.

Updating an Existing Solution
Knowledge Workers can also update an existing or published solution. The 
following is a graphical representation of the tasks associated with updating an 
existing solution

Note: The preceding diagram summarizes the flow for viewing a 
Solution in Progress that has not already been published. For 
solutions that have been published and have subsequently been 
checked out, the user will be prompted to select an authoring flow 
after selecting the Save and Submit button rather than selecting a 
step in the current flow.

Note: The Knowledge: Select Authoring Flow profile option must 
be set to Yes in order for you to have the ability to select an 
Authoring Flow. Otherwise, the solution is submitted to the default 
Authoring Flow.

Note: An updated solution can be rejected back to the author by 
submitting the solution back to the initial draft or authoring status.
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Figure 3–8 Updating an Existing Solution

Updating an existing solution involves the following tasks:

■ Review published solutions: Search for and review a published solution.

■ Can I check this solution out: Determine whether you have proper permissions 
to check out a solution and edit it.

■ Add comments to solution for reviewers: If you cannot check out the solution 
you can add comments for viewing by other reviewers. These comments will 
not be published
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.

■ Check out solution: Determine whether you have proper permissions and 
whether you can approve the solution that someone else has authored.

■ Edit solution: Modify the solution.

■ Save and work on later: Save the solution so that you may work on it later. 

■ Save and submit solution to authoring flow: Save changes and submit the 
solutions to a step/status in the authoring flow, for example, Publish. This step 
effectively checks the solution back in so that other Knowledge Workers can 
check out the solution.

■ Select an Authoring Flow: Select an Authoring Flow to submit the edited 
solution for review.

■ Receive confirmation: Review confirmation that the solution has been 
submitted to an Authoring Flow. You will be able to see to which flow the 
solution has been submitted by checking the status listed on the confirmation.

Searching the Knowledge Base
Knowledge Workers will frequently need to search the knowledge base in order to 
maintain its relevancy. As part of this process, the Knowledge Worker will need to 
determine the search criteria and subject matter and which type of search to 
conduct. Oracle Knowledge Management offers several ways to search the 
knowledge base. The following is a graphical representation of the searches that can 
be performed within Oracle Knowledge Management.

Note: You can also add comments to a solution that you are 
editing.

Note: The Knowledge: Select Authoring Flow profile option must 
be set to Yes in order for you to have the ability to select an 
Authoring Flow. Otherwise, the solution is submitted to the default 
Authoring Flow.

Note: All users of Oracle Knowledge Management will perform at 
least a subset of these search functions.
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Figure 3–9 Searching the Knowledge Base

Figure 3–10 Searching the Knowledge Base

Searching the knowledge base can be accomplished using different searching 
criteria:

■ Basic Search: Basic Search allows you to enter key words to perform a unified 
search for solutions across multiple repositories within the knowledge base. By 
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default, Solutions, Forums, and Categories are the repositories available for 
search.

The Basic Search performs a key word search of the solution title, solution 
number, statement title, and statement description. For categories a key word 
search is performed across the title. For forums a key word search is performed 
across the message subject, message body, and message number.

From the Basic Search page you can also browse Solution Categories. Solution 
Categories are a way to organize the knowledge base. Solution Categories allow 
you to navigate through a hierarchy of categories, subcategories, and solutions 
within the knowledge base. 

Advanced Search: Advanced Search allows you to search for solutions that 
meet specific user defined criteria. This is a more comprehensive search that 
enables you to set conditions, filters, and incorporate similar and identical 
statements into your search. Solutions are made of statements and the advanced 
search allows users to find solutions using statements as the search criteria. The 
advanced search can search similar statements or solutions based on a 
statement. From a given statement, users can find any other solution that uses 
this statement. 

■  Solutions in Progress: Solutions in Progress (formerly known as Work Pending 
in prior versions of Oracle Knowledge Management) is a search that is 
specifically designed to search draft or solutions that are not yet published. This 
search functionality is not available to calling applications directly, although 
users accessing from calling applications can navigate to this page by using the 
menu. Solutions in Progress can be viewed and searched from the Solutions in 
Progress page. Solutions in progress include solutions that have been saved but 
have not been submitted for approval as well as solutions that have not been 
approved for publishing.

■ Statement Search: By searching for a statement you can find the related 
solutions containing that statement. This process is typically only utilized by 
Knowledge Workers and Knowledge Administrators and is a useful way to find 
statements using statement numbers. The Knowledge Administrator can use 
this search to find a statement in order to perform a global update while the 
Knowledge Worker can only use this page to find a statement. In most cases, it 
is more useful to search for statements in conjunction with the Solution 
Advanced Search page rather than using the Search Statements page.
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3.2.3 End User Flows 
End Users searching the knowledge base will access Oracle Knowledge 
Management through the Support tab in Oracle iSupport. End Users will typically 
perform the follow tasks:

■ Conduct a Basic Search (also known as a Unified Search)

■ Browse Solution Categories

■ Review the Top Solutions in Oracle iSupport

The following flows provide a graphical representation of these processes.

Conducting a Basic Search (also known as a Unified Search)
The majority of End Users searching the knowledge base will conduct a key word 
search using the Basic Search (also known as Unified Search) functionality. The 
following is graphical representation of the tasks associated with conducting a basic 
search.

Figure 3–11 Conducting a Basic Search

Conducting a Basic Search involves the following tasks:

■ Enter key word for search: Enter a key word or words.

■ Select a repository or multiple repositories to search: Select a repository such as 
Solutions. Similarly, the user can decide to select all repositories.

■ Review search results: Review search results and decide whether or not to 
modify the search by entering new key words.

■ Review solutions: Review solutions displayed within the search results.
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■ Provide feedback: Indicate whether solution helps to solve your problem by 
clicking a response at the bottom of the Solution Detail page. This information 
is captured in usage counts that populate the Frequently Used Solutions list. 

Browsing Solution Categories
From the Basic Search page, End Users can browse Solution Categories that are 
similar to folders for solutions. The following is graphical representation of the 
tasks associated with browsing Solutions Categories.

Figure 3–12 Browsing Solution Categories

Browsing Solution Categories involves the following tasks:

■ Review solution categories: Review solution categories to determine where you 
might find solutions that meet your needs.

■ Drill down to sub-categories or navigate to other categories: Choose a 
sub-category or select another category.

■ Review solutions in category: Review solution headers and detail to find an 
appropriate solution. 

■ Provide feedback on solution: Indicate whether solution helps to solve your 
problem by clicking a response at the bottom of the Solution Detail page. This 
information is captured in usage counts that populate the Frequently Used 
Solutions list.

Viewing Top Solutions in Oracle iSupport
End Users can navigate to a list of Recommended Solutions and Frequently Used 
Solutions from the Top Solutions subtab in Oracle iSupport. The following is a 
graphical representation of the tasks associated with viewing Top Solutions within 
Oracle iSupport
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Figure 3–13 Viewing Top Solutions in Oracle iSupport

Users of Oracle iSupport can navigate to the Top Solutions subtab to review two 
lists of solutions:

■ Review Recommended Solutions: View a list of recommended solutions. The 
Recommended Solutions list is a list of solutions selected by the Knowledge 
Administrator to display in Oracle iSupport.

■ Review Frequently Used Solutions: View a list of frequently used solutions. The 
Frequently Used Solutions list is based on usage counts. 

■ Change date range of Frequently Used Solution view: Update the view for 
Frequently Used Solutions list by selecting a date definition or range from a 
drop down list. These date definitions or ranges are defined by Knowledge 
Administrators within Oracle Knowledge Management

3.3 Implementation Tasks
You will need to complete the following setup steps in order to implement Oracle 
Knowledge Management. These steps are in addition to Installation and 
Dependency Verification list noted in Chapter 2, "Before You Begin",
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Implementation Steps Flow
The following diagram is a graphical representation of the implementation steps 
described in Table 3–3, "Implementation Tasks"

Table 3–3 Implementation Tasks

Task Reference
Mandatory/ 
Optional Setup

Prerequisites/ 
Implement 
Mandatory 
Dependencies

Chapter 2, "Before You 
Begin"

Mandatory Forms

Create Users and 
Resource Groups

Section 4.2, "Creating 
Users and Resource 
Groups"

Mandatory Forms

Import Solutions Section 4.3, "Importing 
Solutions"

Mandatory Forms/SQL

Set Profile Options 
and Concurrent 
Programs

Section 4.4, "Setting 
Profile Options and 
Concurrent Programs"

Mandatory/ 
Optional

Forms

Set Up Authoring 
Flows

Section 4.5, "Setting Up 
Authoring Flows"

Mandatory Oracle 
Knowledge 
Management

Set Up Knowledge 
Base Structure

Section 4.6, "Setting Up 
the Knowledge Base 
Structure"

Mandatory Oracle 
Knowledge 
Management

Set Up Top Solutions 
for Oracle iSupport 
Users

Section 4.7, "Setting Up 
Top Solutions for Oracle 
iSupport Users"

Optional

Note: You must 
have either 
added or 
imported 
solutions into 
the knowledge 
base in order to 
perform this 
setup.

Oracle 
Knowledge 
Management

Additional Setups Section 6.2, "Additional 
Integration Setups"

Optional Forms/Oracle 
Knowledge 
Management
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Figure 3–14 Implementation Steps Flow
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4
 Implementation Tasks

This chapter includes the implementation tasks required to set up Oracle 
Knowledge Management. The sections in this chapter include:

■ Section 4.1, "Prerequisites and Mandatory Dependencies"

■ Section 4.2, "Creating Users and Resource Groups"

■ Section 4.3, "Importing Solutions"

■ Section 4.4, "Setting Profile Options and Concurrent Programs"

■ Section 4.5, "Setting Up Authoring Flows"

■ Section 4.6, "Setting Up the Knowledge Base Structure"

■ Section 4.7, "Setting Up Top Solutions for Oracle iSupport Users"

■ Section 4.8, "Implementation Considerations"

■ Section 4.9, "Upgrade Considerations"

4.1 Prerequisites and Mandatory Dependencies
For a list of prerequisite and mandatory dependencies refer to Chapter 2, "Before 
You Begin". 

4.2 Creating Users and Resource Groups
The System Administrator creates users for Oracle Knowledge Management 
including the Knowledge Administrator. Subsequently, the Knowledge 
Administrator will need to create Resource Groups which are required for 
automating the authoring flow lifecycle. In order to create a Resource Group you 
must do the following:
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1. Create a user

2. Associate a user with an employee

3. Create a resource for an employee.

4. Create a Resource Group

Below are details on how to create a Knowledge Administrator as well as how to 
create a Resource Group.

4.2.1 Creating a Knowledge Administrator
User access to Knowledge Management follows normal CRM user management 
rules. Access is controlled by specific responsibilities and roles given to users 
through the Oracle Forms user interface and the CRM System Administrator 
Console. 

Responsibility: The System Administrator assigns the administrator responsibility, 
Knowledge Administrator, Vision Enterprises, (CS_KB_SYS_ADMIN), to the user 
who is the Knowledge Administrator. This user performs setups and maintenance 
for Knowledge Management. 

Role: The role assigned to the Knowledge Administrator is CS_SYSTEM_ADMIN. 
(There is no “user friendly” name for this role; the programmatic name and the 
user-friendly name are identical.)

Import Users as Resources: The System Administrator and the Knowledge 
Administrator both must be imported as a resource into CRM Application 
Foundation Resources to be utilized by Knowledge Management.

Setting up a User as a Knowledge Administrator (CS_System_Admin)

Steps
1. Log in to Oracle Forms application as system administrator. Select System 

Administrator responsibility.

2. Navigate to Security > User > Define. The Users form opens.

3. In the Users form, enter the username for the Knowledge Administrator. 

■ Example: Knowledge Management_ADMIN 

4. You must associate the user with an employee. Place your cursor in the Person 
field to enable the Person Names picklist. Search for and select the appropriate 
employee. 
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5. Enter a password for the new user in the Password field. Use the Tab key to 
clear the field and re-enter the same password to validate.

6. In the Responsibilities block, search for and select CS_KB_SYS_ADMIN 
responsibility.

7. Save changes.

Finding Responsibility ID
Use the following steps to find the RESPONSIBILITY_ID value of a 
responsibility. 

a. In Oracle Forms as System Administrator, navigate to Security > 
Responsibility > Define. The Responsibilities form opens.

b. From the top menu, select View > Find. Search for the responsibility.

c. Once found, highlight the responsibility, and click OK in the search 
window. The Responsibilities form is populated with the information for 
the responsibility.

d. With the cursor in any field of the record, select Help > Diagnostics > 
Examine. The Examine Field and Variable Values form opens.

e. In the Examine Field and Variable Values form, select RESPONSIBILITY_ID 
from the Field LOV. The Value field displays the value of 
RESPONSIBILITY_ID. 

f. Make a note of the numerical value displayed in the Value field. Use this 
number as the default responsibility ID at the user level when setting up 
new administrative users in Oracle Forms.

Assign Role(s)
Roles are collections of privileges that control access to specific pieces of 
functionality within a page; these granular access rights are known as permissions. 
A single role can have several permissions.

Follow the steps below to assign the Knowledge Administrator role (CS_SYSTEM_
ADMIN) to the new Knowledge Administrator.

Steps
1. Log in to the JTF login screen as a system administrator. 

2. Navigate to the Users screen:
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■ Users > Registration > User Maintenance

3. In the Users screen, query for the username of the user who will be the 
Knowledge Administrator. 

4. After the search yields the username, click the underlined hyperlink of the 
username to access the User Details screen. 

5. In the User Details screen, click the Roles button to access the User Role 
Mapping screen. A list of available roles will appear, along with a list of 
assigned roles. If this is a new user, the Assigned Roles column will be blank.

6. Highlight the CS_SYSTEM_ADMIN role in the Available Roles column, and 
use the right arrow (>) button to move it to the Assigned Roles column.

7. Click Update to save changes.

8. Sign out.

9. Verify that the new user can log in: Sign in to the JTF login screen as the newly 
created user. 

For additional information on how to assign roles in the CRM System 
Administrator Console, please consult:

■ Oracle Applications CRM Administrator’s Guide

4.2.2 Creating Resource Groups
In order to automate the solution authoring process you must set up Authoring 
Flows in Oracle Knowledge Management. Each authoring flow consists of a series 
of steps which must be completed by a member of an assigned Resource Group 
before a solution can be published.   A Resource Group can include one or more 
users and in order to create a Resource Group you will first need to create a user, 
associate a user with an employee, and create a resource for an employee.

Example 4–1 Resource Group Example

A software company creates an authoring flow that requires all solutions to have a 
technical review and an editorial review prior to publication. In order to ensure that 
the proper controls are in place the company sets up three Resource Groups.

■ Technical_Reviewers: Responsible for technical accuracy of a solution.

■ Editorial_Reviewers: Responsible for formatting and editing content.

■ Solution_Publishers: Responsible for providing final review and approval prior 
to publication.
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Login
Log on to Oracle Applications Forms.

Responsibility
System Administrator

Steps
1. Log on to Oracle Applications Forms as a system administrator. Responsibilities 

window opens.

2. Select Human Resource (HRMS Manager) responsibility for your organization.

3. Navigate to People> Enter and Maintain. People window opens. 

4. You can query for an existing user or create a new user.

5. Associate a user with an employee by following these steps:

a. Switch to System Administrator responsibility.

b. Navigate to Security > User > Define. Users window opens.

c. Query the user by entering some known value in the User name field.

d. Give the user workflow user responsibility. 

e. Save the record.

6. Create a resource for an employee or party by following these steps:

a. Switch the responsibility to the CRM Resource Manager.

b. Navigate to Maintain Resources >Import Resources. Selection Criterion 
window opens.

c. In the Resource Category field, select employee from the list.

d. Enter the employee name or employee number to narrow search criteria. 

e. Select Search. Search Results section is populated with the results.

f. Select Create Resource. Default Values window opens.

g. Enter mandatory and other information. Select OK.

h. Selected Resources window appears. Select Save Resource.

7. Create a resource group by following these steps:

a. Switch the responsibility to the CRM Resource Manager responsibility.
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b. Navigate to Maintain Resources > Groups. The Define Groups window 
opens.

 

c. Enter the group name. Under the Members tab enter the names of the 
employees who will be in the group.

d. Navigate to the Usages tab. Select Oracle iSupport.

e. Save the record.

4.3 Importing Solutions
Use the Knowledge Management Solution Import Program to load solutions into 
Oracle Knowledge Management. This program is a concurrent program which 
means that it runs simultaneously with other programs and/or tasks. A complete 
description of the Knowledge Management Solution Import Program is described 
in Section 4.4.2, "Running Concurrent Programs". Appendix D, "Sample File For 
Knowledge Management Solution Import Program", contains a sample file for the 
Solution Import Program.

4.4 Setting Profile Options and Concurrent Programs
One of the critical components of implementing Oracle Knowledge Management is 
setting the Profile Options and understanding how to use the Concurrent Programs. 

Note: If a group is not available, you must create one by entering 
a group name in the Define Groups window. Select Save.

Note: Employee Resources and Resource Groups can be setup in 
HTML. For information on creating Employee Resources and 
Resource Groups in HTML refer to the Oracle Common 
Application Components Implementation Guide.
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4.4.1 Setting Profile Options
Profile options are seeded within all Oracle applications, and each module has its 
own specific set of profile options. Although all profile options are seeded, there are 
some settings that must be done by a system administrator. 

Profile Options for Knowledge Management
Oracle Knowledge Management has its own set of profile options. 

■ For a listing of all Knowledge Management profile options, their descriptions 
and how to set them up, refer to Appendix B, "Profile Options".

■ For a listing of new Profile Options in this release of Oracle Knowledge 
Management refer to Section 1.4.2, "New Profile Options"

■ For a listing of changed profile options in this release of Oracle Knowledge 
Management refer to Section 1.5.3, "Changed Profile Options"

■ For a listing of obsoleted profile options in this release of Oracle Knowledge 
Management refer to Section 1.6.1, "Obsolete Profile Options"

4.4.2 Running Concurrent Programs
Concurrent programs run simultaneously with other programs and/or tasks. 

Concurrent Programs for Knowledge Management
The following list describes the Concurrent Programs used for Oracle Knowledge 
Management:

■ Knowledge Management Index Synchronization Program to synchronize the 
Oracle Text index to display the solutions in the search process. With this 
release, the Index Synchronization program also synchronizes the new forum 
index.
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■ Knowledge Management Update Solution Used Count Program to update the 
solution used count for frequently used solutions/common problems. 

■ Knowledge Management Solution Export Program to export solutions from 
Knowledge Management. It is a PL/SQL concurrent program that exports 
solutions from Knowledge Management using the user specified criteria. The 
results are saved in the XML format in the concurrent programs “out” file. This 
concurrent program downloads the solutions based on the following criteria:

■ the category name from which the solutions have to be downloaded

■ the status of all the solutions in a category, for example, Published or All

■ Knowledge Management Solution Import Program to import new solutions 
and to update existing solutions in Knowledge Management. It is a Java 
concurrent program that can upload multiple solutions. The solutions to be 
imported can either be new solutions or existing solutions with updates. The 
Program uses the input xml file name (absolute path) and commit interval (how 
often to commit the import) parameters for running. The File has to contain the 
solutions in a XML format and have to be compliant with the Document Type 
Definition (DTD) for Knowledge Management, cskb_solution.dtd. This 
program checks the validity of the input xml document. If it is valid, the 
solutions are created, one after the other. If any data is invalid, the solutions are 
not created. If processing for any one solution fails, its changes are rolled back, 
and a log error message is written and the next solution in the file is imported. 
Each new solution to be uploaded can either have a Saved status, or it can be 
directly published, if the flow information is provided. Only published 
solutions can be updated, and have a published status after update. 
Attachments and external links are not supported but Statement Global Update 
is supported. Any statement with a statement number is globally updated 

Note: Newly published solutions are not automatically indexed 
into the search process, which means that, although a solution has 
been approved for publishing it may not be searchable. Knowledge 
Administrators should run the Knowledge Management Index 
Synchronization program to add newly published solutions to the 
index. 

If an existing published solution is revised and republished, the 
solution is not searchable until the Index Synchronization program 
is run.
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according to the new data specified in the XML document. To see an example of 
a DTD file see Appendix D, "Sample File For Knowledge Management Solution 
Import Program"

 

Login
Log on to Oracle Applications Forms.

Responsibility
No responsibility is provided by default. You have to create your own 
responsibility.

Prerequisites
An assigned user with appropriate responsibility to run the above programs.

Steps
1. Log on to Oracle Applications Forms as a CRM System Administrator. 

Responsibilities window appears. 

2. Select the System Administrator responsibility.

3. Navigate to Security > Responsibility > Define. Responsibilities window opens. 

4. Query your system administrator responsibility to get the request group name 
for it. A request group is a collection of reports or concurrent programs. Your 
responsibility’s request group determines the requests that appear in the 
Submit Request window.

5. Navigate to Security > Responsibility > Request. Request Groups window 
opens. 

6. Query the request group name obtained for your system administrator 
responsibility.

7. Under the Requests section, add the concurrent request if it does not already 
exist.

Note: The Knowledge Management Solution Import Program is 
not used by Knowledge Workers. It is typically run once at the 
beginning of an implementation.
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8. Enter information in the following fields: 
Type = Program 
Name = concurrent program name

a.  To synchronize the InterMedia index:

■ concurrent program name = Knowledge Management Index 
Synchronization Program

b. To update the solution used count for frequently used solutions:

■ concurrent program name = Knowledge Management Update Solution 
Used Count Program

c. To export Solutions from Knowledge Management

■ concurrent program name = Knowledge Management Solution Export 
Program

d. To import new solutions and/or update existing solutions within 
Knowledge Management

■ concurrent program name = Knowledge Management Solution Import 
Program

9. Save the record.

Running a Concurrent Request
1. If required, switch the responsibility to system administrator.

2. Navigate to Concurrent ->Requests. Find Requests window opens.

3. Select Submit a New Request.

4. Select Single Request. The Submit Request window opens.

5. Select the concurrent request (program) that you want to run.

6. Enter the required parameters. The concurrent programs can be scheduled to 
run periodically.

7. Select Submit to submit the request. You receive a confirmation that a request 
has been submitted.

Viewing the Concurrent Request Status
1. Navigate to Concurrent -> Requests. Find Requests screen opens.
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2. You can enter the Request Id, or any other criteria to search for a request, or 
select All My Requests.

3. Select Find. The Requests screen opens.

4. Select Refresh Data to see the latest status

4.5 Setting Up Authoring Flows
In order to automate the solution authoring process you must set up Authoring 
Flows in Oracle Knowledge Management. Each authoring flow consists of a series 
of steps which must be completed by a member of an assigned Resource Group 
before a solution can be published.

Example 4–2 Authoring Flow Example

A health and fitness equipment manufacturer company creates an authoring flow 
that requires all solutions in the knowledge base to have an editorial review and 
marketing approval prior to publication. In addition, the company would like to 
ensure the legal review team has final authority on publication of a solution. In 
order to ensure that the proper controls are in place the company sets up three steps 
in the authoring flow and associates a unique resource group to each step. The table 
below details the steps and resource groups assigned.

For information on setting up Authoring Flows refer to the Oracle Knowledge 
Management User Guide.

4.6 Setting Up the Knowledge Base Structure
In order to effectively manage Oracle Knowledge Management it is critical to spend 
some time designing the structure of the knowledge base. Oracle Knowledge 
Management allows you to set up structures that help organize and partition 
information within the knowledge base. Creating a knowledge base structure that is 

Table 4–1 Authoring Flow Example

Authoring Flow Step Name Resource Group Assigned

Format and Edit Review Editorial_Reviewers

Marketing Approval Marketing_Approval

Publish Legal_Reviewers
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either overly complex or simple will minimize the effectiveness of the knowledge 
base.

The knowledge base is comprised of a series of solutions which contain statements 
that are designed to help solve problems. In order to organize how solutions are 
created and identified, Oracle Knowledge Management requires that all statements 
be associated to a statement type and all solutions be associated to a solution type.   
Each solution type must have at least one statement type associated to it. In 
addition, Oracle Knowledge Management provides the ability to create Solution 
Category folders to help organize the knowledge base.

 

Following is a description of Solution Types, Statement Types, and Solution 
Categories. You can find more information on setting up these structures in the 
Oracle Knowledge Management User Guide. 

Statement Types
The most granular level of information in the knowledge base is a statement. 
Statements are the main source of information contained within the solution. Each 
statement is classified into a statement types that helps identify the type of 
information contained in the statement. An example of a statement type is an 
Action, or a statement that directs the user to do a particular task in order to solve 
an issue. 

Example 4–3 Statement Type Example

Statement Type: Action

■ Action Statement: Replace ink cartridge in printer

Solution Types
Similarly, solutions are assigned to solution types that classify the solution. The 
solution type identifies the mandatory statement types contained within the 
solution. The default solution type is the Symptom/Cause/Action which by 
definition contains at least one Symptom statement, one Solution statement, and 
one Action statement. 

Note: Solution Types represent the types of solutions in the 
knowledge base. Statement Types are then associated to these 
Solution Types to help form the structure for the solutions.
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Example 4–4 Solution Type Example

Solution Type: Symptom/Cause/Action

■ Symptom Statement: Printer is not printing clearly

■ Cause Statement: Ink cartridge is low

■ Action Statement: Replace ink cartridge in printer

Solution Category
After a solution is created it can be filed into a Solution Category folder that 
contains a set of related solutions. An example, a solution that covers replacing a 
printer ink cartridge might be filed into a Solution Category folder called Printers 
with similar solutions.

Example 4–5 Solution Category Example

Solution Category: Printers

■ Solution 100: Printer is not Printing Properly

■ Solution 150: Printer has a Paper Jam

■ Solution 999: Printer is Offline

4.7 Setting Up Top Solutions for Oracle iSupport Users
Within the Oracle iSupport user interface a user can navigate to a subtab called Top 
Solutions. From the Other Recommended Solutions page users can view a list of 
Frequently Used Solutions as well as a list of Recommended Solutions.

 

■ Frequently Used Solutions are populated based on usage counts captured in 
Oracle Knowledge Management as well as by the date definition set up within 
Oracle Knowledge Management.

■ Recommended Solutions are a listing of solutions chosen by a Knowledge 
Administrator or Knowledge Worker and set up in Oracle Knowledge 
Management.

Note: You must have either added or imported solutions into the 
knowledge base in order to perform this setup.
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For information on defining dates for Frequently Used Solution or information on 
setting up Recommended Solutions refer to the Oracle Knowledge Management User 
Guide.

4.8 Implementation Considerations
The following implementation considerations should be taken into account before 
implementing of Oracle Knowledge Management

4.8.1 Customizing Messages
Oracle Knowledge Management utilizes Oracle Workflow. You can only customize 
messages that are used in workflow.

4.8.2 Setting Up Guest Users
The Guest User concept allows unregistered or registered users to access certain 
features within Oracle Knowledge Management without having to log in.

A Guest User is a user who comes to the site and does not log in explicitly, but 
implicitly to the applications to use certain functionality. The Knowledge 
Management Guest User will be able to use the following pages at specified 
locations (URLs) without explicitly logging in to the applications:

■ Unified Search and Browsing Pages

■ Search Result Pages

■ View Solutions Detail page

When a normal user has not logged in to the applications but uses the URL to open 
any of the above pages, the application will render the page in guest user mode, 
with the login icon. Users can log in to see pages for their respective role and 
permissions.

Refer to the Oracle iSupport Implementation Guide for more information.

Note : Guest User Support in Oracle Knowledge Management is 
made possible through the Oracle iSupport interface.
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4.8.3 Defining the Unified Search Repositories 
With Basic Search (also known as Unified Search) you can search from different 
repositories. To plug in different repositories into the Unified Search you will need 
to do the following. 

Login
System Administrator Console within the CRM Technology Foundation (JTT).

Responsibility
CRM HTML Administration

Steps
1. Define the new repository in JTT QuickFind framework.

2. Append the category of the new repository to the profile option 'Knowledge: 
Available Repositories'. The category of the new repository is the value of the 
JTT property 'service.<classpath>.categories'. 

For more information refer to the Oracle Applications CRM System Administrator’s 
Guide.

3. Bounce the web server

4.8.4 Functions for Configuring Oracle iSupport Pages
You can configure the high-level look and feel of the user interface (UI) for the 
Browser, Search Results, and Solution Details pages that are exposed in Oracle 
iSupport by defining the appropriate JSP name in the FND functions listed below: 

■ Top: Indicates JSP will display at the top of the content page.

■ Left: Indicates JSP will display at the left of the content page.

■ Right: Indicates JSP will display at the right of the content page.

■ Bottom: Indicates JSP will display at the bottom of the content page. 

Refer to the Oracle iSupport Implementation Guide for more information.

Browse Pages Functions
■ CS_KB_BROWSE_TOP_FN - Top section of Browse page 

■ CS_KB_BROWSE_LEFT_FN - Left section of Browse page 
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■ CS_KB_BROWSE_RIGHT_FN - Right section of Browse page 

■ CS_KB_BROWSE_BOTTOM_FN - Bottom section of Browse page 

Search Pages Functions
■ CS_KB_SEARCH_RESULT_TOP_FN - Top section of Search Result page 

■ CS_KB_SEARCH_RESULT_LEFT_FN - Left section of Search Result page 

■ CS_KB_SEARCH_RESULT_RIGHT_FN - Right section of Search Result page 

■ CS_KB_SEARCH_RESULT_BOTTOM_FN - Bottom section of Search Result 
page 

Solution Detail Functions
■ CS_KB_SOLN_DETAIL_TOP_FN - Top section of Solution Detail page 

■ CS_KB_SOLN_DETAIL_LEFT_FN - Left section of Solution Detail page 

■ CS_KB_SOLN_DETAIL_RIGHT_FN - Right section of Solution Detail page 

■ CS_KB_SOLN_DETAIL_BOTTOM_FN - Bottom section of Solution Detail page

4.9 Upgrade Considerations
The following upgrade considerations should be taken into account before 
upgrading Oracle Knowledge Management:

Text Indexes
While patching to upgrade Oracle Knowledge Management the Oracle Text indexes 
used by Oracle Knowledge Management will be dropped and recreated. This may 
extend patching times if a lot of solutions are contained in the system.

Platform Attributes
If you set the profile option Knowledge: Display Platform Attributes to No, all 
solutions updated afterward will have the platform attributes removed if they 
initially had any platform attributes.

Original Author Columns
CS_KB_SETS_B has two new columns that will be updated for existing solution 
version rows.

■ ORIGINAL_AUTHOR
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■ ORIGINAL_AUTHOR_DATE

These columns represent the author and creation date of the solution's first version. 
For solution versions, the last update date and updated by information is stored in 
the standard who columns against each solution version.

For existing solutions, these column values will be derived from the CREATED_BY 
and CREATION_DATE of the first solution version. The default value for these new 
columns as new solution versions are created will be ORIGINAL_AUTHOR and 
ORIGINAL_AUTHOR_DATE of the first solution version.

Link Type Column
The LINK_TYPE column in CS_KB_SET_LINKS now cannot be nullified and 
defaults to PS (Possibly Useful). The existing solution link data rows that are null 
are updated to reflect this. The default value of LINK_TYPE (PS) can be changed 
later using the TeleService applications to Useful or Not Useful.

Data Rows
The data rows that link an attachment to a solution will be migrated from CS_KB_
SET_LINKS (object code = CS_KB_FND_LOBS) to the standard FND owned 
attachment tables.

Note : This new feature will impact existing transactions in the 
system.

Note : This new feature will impact existing transactions in the 
system.
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5
Verifying Knowledge Management

Implementation

5.1 Verification of Knowledge Management Implementation
To check that you have implemented Oracle Knowledge Management correctly, 
verify the following steps:

Steps
1. Verify that you have assigned CS_System_Admin role to a user and assigned 

CS_KB_SYS_Admin responsibility to a user for administrative privileges.

2. Verify that you have set up Oracle CRM Technology Foundation profile options.

3. Verify that you have set up the Oracle Knowledge Management profile options.

4. Verify that you have created one or more resource groups for authoring flows.

5. Verify that you have set up one or more authoring flows.

6. Verify that you have permissions to run the following concurrent programs:

■ Knowledge Management Solution Export Program

■ Knowledge Management Solution Import Program

■ Knowledge Management Index Synchronization

■ Knowledge Management Update Solution Used Count

7. Verify that you have set up the solution authoring profile for one or more users 
in one or more resource groups.

8. Verify that you can perform the following steps in Knowledge Management:

a. Create, view, and update a solution type. 
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b. Create, view, and update a statement type. 

c. Associate, and disassociate a statement type to a solution type.

d. Relate statement types to note types via an external links.

e. Create and modify categories.

f. Create a new authoring flow, and edit an existing authoring flow.

g. Create a solution.

h. Create a statement.

i. Submit a solution to an authoring flow.

j. View and search Solutions in Progress.

k. Publish a solution.

9. Verify that you can perform the following steps:

a. Add or update frequently used definitions for solutions.

b. Set up recommended solutions.

10. Verify that you can perform the following tasks in Knowledge Management: 

a. Basic search (also known as a Unified Search).

b. Advanced search 

c. Search for a statement
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6
Oracle Knowledge Management

Integrations

This chapter provides an overview and a list of all products with which Oracle 
Knowledge Management integrates. In addition, the chapter provides additional 
setup steps required for integrating with Oracle Knowledge Management. The 
sections in this chapter include:

■ Section 6.1, "E-Business Suite Integrations"

■ Section 6.2, "Additional Integration Setups"

6.1 E-Business Suite Integrations
Oracle Knowledge Management is a web based information management system 
that enables a user to efficiently search, create, distribute, and manage information. 
For an end user, Oracle Knowledge Management is an easy to use self-service 
application in which they can enter natural language queries for retrieving and 
solving their own issues. A customer support agent can use Oracle Knowledge 
Management as a powerful solution management tool. Solutions created in Oracle 
Knowledge Management are immediately available to users of all applications that 
integrate Oracle Knowledge Management, based on their access level. The 
availability of information at all times in organizations means quicker response for 
support calls with no long phone queue waits for the end users. This enhances 
customer satisfaction while cutting the costs of customer support and improving 
the productivity of service organizations. 

The tight integration that Oracle Knowledge Management has with several Oracle 
products allows the users of these modules to easily move data between 
applications.   
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Oracle Knowledge Management integrates with other Oracle modules such as 
Oracle Field Service, Oracle TeleService, and Oracle Depot Repair. This integration 
provides service agents for these modules easy access to solutions. 

Oracle Knowledge Management also integrates with Oracle iSupport which enables 
users of Oracle iSupport to resolve their own service issues.

6.1.1 Forms-Based Applications

6.1.1.1 Oracle TeleService
Oracle TeleService (Support module) is a Service Request Management System that 
integrates with Oracle Knowledge Management for resolving customer issues. 
Oracle TeleService uses Oracle Knowledge Management to leverage a knowledge 
base of previously reported problems and solutions. As new service requests are 
logged, agents can search the knowledge base to identify existing solutions that can 
resolve customer issues or contribute new solutions to the knowledge base. A user 
can navigate from the View Service Request Form to Advanced Search screen of 
Oracle Knowledge Management. A solution created in Oracle Knowledge 
Management can also be linked to a Service Request. Notes in a service request are 
used to document the description and progress made in resolving a customer issue. 
Notes are used to capture details to search the knowledge base for solutions and 
statements. Notes are also used to create new statements to contribute to the 
knowledge base. An agent has to use certain note types for searching the 
knowledge base. Examples of note types to be used for searching are Symptom, 
Cause, Action, Problem, and Solution.

The following information from the service request is passed to the Solution 
Advanced Search page.

■ If your note was saved in the service request using a Note Type that has been 
mapped to a statement type in Oracle Knowledge Management, then the note 
text is defaulted to the search screen. 

■  Product

■  Service Request summary is defaulted into the Keywords for searching.

Note : Only those note types that have been mapped to statement 
types will be used as search criteria
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You can view the details of all solutions found in the search and select the solutions 
that are useful for the resolution of your service request. You can also link relevant 
solutions to your service request.

 See the latest version of Oracle TeleService User Guide for more information.

6.1.1.2 Oracle Depot Repair                                                                                                                                                                                   
Oracle Depot Repair is designed to track and manage the repair process in a service 
organization. This application reduces customer downtime and helps bridge the 
gap while the product is being repaired. 

Oracle Knowledge Management allows an agent in Oracle Depot Repair to review 
the full problem solution life span, starting from the initial diagnosis of a problem to 
problem resolution. A Depot agent can search for a solution for a repair order by 
navigating to the Advanced Search screen. Product and work summary of the repair 
order are copied to the Advanced Search screen. A solution can also be linked to a 
repair order. 

See the latest version of Oracle Depot Repair User Guide for more information.

6.1.1.3 Oracle Field Service
The Oracle Field Service suite supports an automated process used by service 
organizations to manage their field service operations. It assists in the entire service 
process from taking the customer call to fixing and reporting on the problem at a 
customer site.The Field Service suite offers a range of products to meet an 
organization’s business needs. 

The Field Service application assists in assigning tasks to service representatives, 
creating and dispatching daily schedules, and monitoring progress.

Service requests are analyzed by a support agent who searches Oracle Knowledge 
Management for a solution and creates a task based on the problem description and 
action needed to solve the problem.

See the latest version of Oracle Field Service User Guide for more information. 
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6.1.2 HTML-Based Applications

6.1.2.1 Oracle iSupport
Oracle iSupport is a customer service portal that allows both customer and 
employee users of a service organization to resolve their issues themselves and to 
receive assisted service over the Internet. It is designed to enhance customer 
satisfaction while cutting the costs of customer support and improving the 
productivity of service organizations.

Oracle iSupport integrates with Oracle Knowledge Management to search for 
published solutions. A service request agent using Oracle iSupport can search for 
solutions while creating a service request. Oracle iSupport customers can also 
search Oracle Knowledge Management to find solutions without waiting for a 
service agent’s assistance.

In the Create Service Request flow, an iSupport administrator can enable a 
knowledge base search by setting up Oracle iSupport: Search Knowledge Base 
profile option.

An iSupport user can view a solution by either selecting the Support tab or by 
selecting Find a solution link in How Can We Help You? bin. He can either search 
for a solution or navigate to a solution listed in the Common Problems and 
Recommended Solutions section. The Solution Details appear. A user can provide 
feedback on the solution by selecting Yes or No for “Can this solve your problem” 
question. He can also select the Add to Quick Links link or select the Create Service 
Request button to navigate to Create Service Request screen.

 See the latest version of Oracle iSupport User Guide for more information.

6.1.2.2 Oracle eMail Center
Oracle eMail Center is the module for managing inbound email interactions with 
customers, partners, suppliers, employees, and others that interact with an 
organization. Oracle eMail Center provides an agent with tools and capabilities to 
maximize their productivity and effectiveness. 

Oracle Knowledge Management integrates with Oracle eMail Center during 
inbound email processing. Oracle Knowledge Management can be searched for 
appropriate solutions by Oracle eMail Center agents while responding to an email. 
The searched solutions can be sent as an e-mail message to the customer.

See the latest version of Oracle eMail Center User Guide for more information. 
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6.1.2.3 Oracle Partners Online
Oracle Partners Online is the entry point for Partner Relationship Management 
(PRM) services across the pre-sales, sales and post-sales inter-company processes 
for companies and their partners. These services include partner profiling and 
opportunity matching for the vendor, and online access to latest product collateral 
as well as sales and service support for the partners.

Users of Oracle Partners Online can access the Support tab in iSupport. See the 
latest versions of Oracle Partners Online User Guide and Oracle iSupport User Guide for 
more information.

6.1.2.4 Oracle Quality Online (OQO)
Oracle Quality Online is a web-based application that can be used by organizations 
to track and manage product defects and enhancements. The resolved defects in 
Oracle Quality Online can be submitted to Oracle Knowledge Management as 
solutions. This increases the knowledge base of solutions and allows users of both 
modules to search for existing solutions and to prevent duplicate defect entry. If an 
agent decides to submit a created defect to Oracle Knowledge Management, then an 
OQO agent can navigate to Oracle Knowledge Management. Published notes in the 
defect can also be copied to Oracle Knowledge Management, if the Defect Note 
Types had been mapped to Oracle Knowledge Management statement types.

Oracle Knowledge Management also uses the Token Rules or dynamic linking 
functionality developed in OQO. See the latest version of Oracle Quality Online User 
Guide for more information. 

6.2 Additional Integration Setups
The following setups are designed to take advantage of the integration points 
within the Oracle E-Business Suite.

6.2.1 Mapping a Statement Type to a Note Type
The Notes is a Common Application Component within the Oracle E-Business 
Suite. It is seeded with a set of predefined note types which can be used throughout 

Note: Oracle Quality Online is supported but no migration is 
offered.
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the Oracle e-Business Suite. Individuals with the CRM administrator responsibility 
can also create additional customized note types. 

Notes in a Service Request are used to document the description and progress made 
in resolving customer issues. Notes are used to capture details that can be used to 
search the knowledge base for solutions or to create new solutions. See Oracle 
TeleService User Guide for more information.

Each Note Type can be mapped to one Statement Type. This mapping is used to 
translate notes from other objects, especially service requests, into statement types 
in Knowledge Management. 

Responsibility
Knowledge Administrators with edit permissions (CS_Type_Edit) can relate a 
statement type to a JTF note type.

Prerequisite
This integration is primarily used with Oracle TeleService.

Steps
1. Create a new statement type or navigate to an existing statement type.

2. In the Related section, select External Links from the drop-down box.

3. Select Add. The Select an External Object screen appears. Select Note Type.

4. The Note Type screen appears. Search for the note type that you want to 
add to this statement type. Use (%) in Description field for a wildcard 
search. 

5. From the Search results select the JTF note type to add to the statement 
type. Select Update.

6.2.2 Setting Up Note Token Rules (also known as AutoLinks)
Setting up Note Token Rules in Oracle Quality Online allows you to define parsing 
rules and destinations for hyperlinking keywords in the Note Details display. This 
is known as an AutoLink in Oracle Knowledge Management.

AutoLinks define a set of key token words, for example, bug that maps to an html 
object in the database. If the word bug has been created as a note token rule, when a 
solution is authored containing bug and an unique parameter (the bug number), for 
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example bug: 10020, Knowledge Management will automatically create a hyperlink 
to that object in the database. 

AutoLinks allows you to create links automatically to other objects in the database 
which is useful in building a knowledge base where information is linked together.

To create Token Rules:

Login
Navigate to the Oracle Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
Quality Online Administrator

Prerequisites
None.

Steps
1. Navigate to Token Rules > Summary.

2. Click Create Token Rule.

3. Type a unique Name in the Name text field.

4. Type a description in the Description text field.

5. In the Token section, type the keyword to hyperlink in the Value field. (a name 
for the linked text, e.g. http://, etc.)

6. Set Preceding and Following Delimiting Characters. The Preceding Delimiting 
Characters distinguish your token value from identical text values, and the 

Note: For statement details with content type Text with Autolink, 
you cannot use the characters listed below as the preceding or 
following characters: < > " ' % ; ( ) & ! 

However, you can use these characters as the preceding or 
following characters for statement details with content type HTML 
with Autolink. 



Additional Integration Setups

6-8 Oracle Knowledge Management Implementation Guide                              

Following Delimiting Characters determine where the hyperlink stops. Any 
combination of Following Characters are allowed between Token Value and 
Parameter, if any.

7. In the Parameter section, use the Type list to choose a Parameter type 
Alphanumeric, Numeric or No Parameter.

8. Enter the Following Delimiting Characters for the parameter, if desired, and/or 
check the appropriate delimiting boxes. If No Parameter is selected, then the 
Following Characters, Minimum Length, and Maximum Length options are not 
allowed

9. Enter your minimum and maximum length parameters

10. In the Destination section, choose a Type using the list. If your type is Function, 
choose a User Function Name using the list. If your type is URL, enter the base 
url in the Base URL text field.

11. Click Create. The token rule displays on the Token Rules summary page.

In order for this token rule to be leveraged in Knowledge Management, it must 
be mapped to the Knowledge Base Solution object in the database.

To map a token rule to an object:

12. Click the Mapping sub tab. The Token Rule Mapping page displays.

13. Select the Knowledge Base Solution value from the Object list and click Go. The 
page is populated with the values that have already been mapped to the object.

14. Type a number in the Sequence field.

15. Select the Token Rule you created from the Rule list.

16. Select a Start Date.

17. Select an End Date.

18. Click Update. The token rule is mapped to the Knowledge Base Solution object.

6.2.3 Integrating with the Oracle Knowledge Management Basic Search (also known 
as Unified Search)

Basic Search (also known as Unified Search) allows you to enter key words to 
perform a unified search for solutions across multiple repositories within the 
knowledge base. With this release of Oracle Knowledge Management, a Forum 
search has been added. In addition, the Solution Category search and the Solution 
search have been merged. Users performing a unified search will be able to search 
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both the Solution and Forums repositories. Searching the Solution repository will 
return results in both Solution and Solution Category. 

In order to fully leverage Oracle Knowledge Management’s unified search 
functionality from an integrated application you will need to add a key/value pair 
through the System Administrator Console within the CRM Technology Foundation 
(JTT). For more information on adding properties or key/value pairs refer to the 
Oracle Applications CRM System Administrator’s Guide.

Login
Navigate to the Oracle Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Responsibility
CRM HTML Administration - System Administrator Console within the CRM 
Technology Foundation (JTT)

Steps
1. Navigate to Settings > System > Properties > Advanced

2. From the View list, select the CS product code.

3. Click Create to add a new key. The Create Key page displays.

Note: The profile option Knowledge: Available Repository For 
Search determines which of the repositories defined in JTT are 
available to search. The default value for this option is 
SOLUTIONS, FORUMS.

Note:  The changes noted above are only applicable to the unified 
search functionality in Oracle. Unified Search is set up differently in 
Oracle iSupport. For information on setting up Oracle iSupport 
refer to the Oracle iSupport Implementation Guide.
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4. Type 
service.oracle.apps.cs.knowledge.bean.SolutionCategorySearchFactory.catego
ries in the Key Name field 

5. Edit the table.

a. Type 0 into the Sequence field.

b. Type SOLUTIONS into the Value field.
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7
Diagnostics and Troubleshooting

7.1 Common Problems and Solutions 
This chapter provides instructions on how to correct errors and provides 
workarounds for common problems that you may experience in configuring or 
administering Oracle Knowledge Management.

What are the factors that determine the solution search results in Oracle 
Knowledge Management?
In Oracle Knowledge Management, a distribution level attribute is used for 
solutions and an access level attribute for users to control the access of solutions to 
different users.

Distribution levels are linearly arranged (low to high) and have a number 
associated with them. There are four seeded distribution levels:

■ Restricted (highest security) > 900

■ Internal > 1000

■ Limited > 2000

■ External (lowest security) > 3000

When solutions are created, they are assigned a distribution level by the author. The 
distribution levels LOV is defined in the CS_KB_ACCESS_LEVEL Lookup type.

Users are assigned a similar attribute called an access level. Access levels are 
numeric and assigned based on the user's assigned permissions. The numeric 
values associated with viewing a solution are the following:

■ CS_Solution_View_Restricted > 900

■ CS_Solution_View_Internal > 1000



Common Problems and Solutions

7-2 Oracle Knowledge Management Implementation Guide                             

■ CS_Solution_View > 3000

Solution distribution levels and a particular user's access level are compared, during 
searching, to filter the solutions that a user can see. Users having a particular access 
level can only see solutions having a distribution level with a higher numeric value. 
When a user searches for a solution in Knowledge Management, the search results 
are affected by the following factors: 

■ User access level (internal or external) 

■ Solution distribution level 

■ Solution versions (Published, Draft, Obsoleted, etc.) 

The following business rules apply: 

■ For External Users with CS_Solution_View permission (For example, 
iSupport, Customer users): Only the external solutions that are marked as 
published are shown.

■ For Internal Users with CS_View_Internal and CS_View_Restrict 
permissions (For example, iSupport, Employee users): Only the internal or 
external solutions that are marked as published are shown. 

Why can’t I find a new solution using Advanced or Basic Search pages?
A solution has to be indexed before it can be retrieved through a search in any of the 
search screens. To search and view new solutions, you have to first run the 
Knowledge Base Sync Index concurrent program to refresh the solutions and the 
solution count in the knowledge base.

To see the solutions, you need to make sure that you have the appropriate access 
level.

Sometimes search fails if an invalid package like CS_KNOWLEDGE_PVT is 
installed in your environment. 

When I try to do a Basic Search for a solution, I get the following error 
message: java.sql.SQLException: ORA-20000: interMedia Text error: 
DRG-10599: column is not indexed.
Confirm that Oracle Text (formerly Oracle Intermedia text) has been set up correctly 
in your environment and whether the listener is up.

The other cause of the error may be that Intermedia index may not be getting built 
in your environment during the installation. You can rebuild the index by running 
the following script.
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$CS_TOP/patch/115/sql/cskbctxc.sql 

Read the comments on the top of the sql script for parameter information. 

What does the following error indicate:java.sql.SQLException: 
ORA-20000: interMedia Text error: DRG-10599: column is not indexed? 
The intermedia index column on your environment is not indexed, or the index is 
not being rebuilt. Drop and create index and make sure it is valid. 

Index belongs to the CS schema. Log on with a CS responsibility and manually drop 
the solution index: 

CS_KB_SETS_TL_N3 force 

Run the index creation script: 

$APPL_TOP/cs/patch/115/sql/cskbctxc.sql <cs user> <cs password> apps applsys 

My browser is javascript enabled yet some of my links do not work. 
■ Bounce the apache server and clear the OA_HTML/ jsp caches

■ Check NLS_LANG settings

■ Remove any invalid objects

I get the following java error when I click on Find Similar Statements on 
the Solution Detail Screen: java.sql.SQLException: ORA-20000: 
interMedia Text error: DRG-10599: column is not indexed. 
The Intermedia Index is missing. You need to recreate the index. You can rebuild the 
index by running the following script.

$CS_TOP/patch/115/sql/cskbctxc.sql 

Upon launching the Oracle Knowledge Management HTML user 
interface from the Service Request form I receive the following error: 
“User does not have proper permissions” 
Please grant one or more of the following roles to your user:

■ CS_Support_Agent

■ CS_Knowledge_Worker

■ CS_ System_ Admin 
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How do I publish a statement?
A newly created statement is in a draft status by default. It is published when the 
solution for which it is initially created is published. 

When I navigate to Oracle Knowledge Management from Oracle 
TeleService and try to do a Basic or an Advanced search I do not get 
search results. 
Run the Knowledge Base Sync Index concurrent program to reindex the Knowledge 
Management solutions. 

Make sure that the solutions that you have created and submitted are not in the 
draft status. The solutions have to be in the published status to be reindexed. 

Why can’t I edit a statement in a published solution that I am able to 
check out?
Only a Knowledge Administrator has the permissions to edit a statement in a 
solution that has been published. An administrator can search a statement from the 
Search Statement screen. 

The CS_Statement_Global_Update permission is only given to Knowledge 
Administrators to prevent knowledge workers from changing the statements that 
are shared between other solutions. 

As a member of a resource group assigned to all steps in an authoring 
flow, how can I get an e-mail for a solution that I created and submitted 
to that authoring flow? 
To get an E-mail notification for a solution, you need to make sure that: 

■ In the workflow user preference setup, HTML mail has been selected 

■ You have subscribed to the products/categories related to the solutions that you 
are interested in from the Solution Authoring Profile screen

■ E-mail id should be attached to an employee

■ System admin workflow notification is set up 

■ Ensure that the mail notifier in your environment is working
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When are e-mail notifications sent to users belonging to a step in an 
authoring flow?
E-mail notification is sent when a solution is submitted to the step that you are 
assigned to and you have subscribed to the product /category to which the solution 
is related.

In Oracle TeleService, after I click the Yes button for “Does the solution 
solve your problem” and after clicking Exit from Knowledge 
Management button and the Refresh button on the TeleService 
Workbench tab, the solution does not appear in the Notes and 
Knowledge section and the row is not being added to the CS_KB_SET_
LINKS table. 
For the solution to appear in the Notes and Knowledge section and for a row to be 
added linking the service request and the solution in the CS_KB_SET_LINKS table, 
make sure that other_id is the same as the service request id and object_code is the 
same as the SR string.

Make sure that the profile option Knowledge: Action for Positive Solution Feedback 
is set up to link solution as solved.

Also, clear the IBU and CS caches and bounce the server. 

Why do I not get results when I use Oracle Knowledge Management 
from Service Request to search for a solution?
Check if the package cs_kb_ctx_pkg is installed in your environment’s ctxsys 
schema. If this package is not installed or is improperly installed, then the 
intermedia text indexes will not be properly populated and you will not be able to 
find anything in the knowledge base. Install the package by running the $CS_
TOP/patch/115/sql/cskbctxs.pls and cskbctxb.pls scripts. Use the parameters as 
documented in the scripts and then rebuilt the index. 

Where are the attachments to the solutions within Oracle Knowledge 
Management stored?
Attachments to solutions in Oracle Knowledge Management are stored in the 
database through JTT attachments. For more information on JTT Attachments, see 
the latest version of Oracle Common Application Components User's Guide.

When are solutions marked for re-indexing?
Whenever a solution is updated, it is marked for reindexing.



Common Problems and Solutions

7-6 Oracle Knowledge Management Implementation Guide                             

Why is the text that I enter in the Statement Summary field saved as a 
JSP file on the hard disk when I click the Export button on the Statement 
Detail screen?
It is an Internet Explorer bug. You have to download and install a patch containing 
this fix from the Microsoft website.

When are statements considered duplicate?
Statements are considered duplicate if they have the same summary, same type, 
same distribution, and same details.

How do I delete a solution?
Deleting solutions is not allowed in this release of Oracle Knowledge Management. 
You can perform a soft delete by creating an authoring flow to obsolete a solution. 

Can I end date a solution type?
You can end date solution type. End dating a solution type will prevent any further 
solutions of this type from being created after the end date has expired. Solutions 
currently in progress will be allowed to complete. End dating does not delete the 
solution type from the database. 

I get the following error while submitting a solution to the next step in a 
workflow: ORA-20160: Encountered an error while getting the ORACLE 
user account for your concurrent request to run from. Review your error 
messages (Help Error) to see the cause of the error. Contact your 
system administrator.
Navigate to Oracle Applications Forms and log in as a system administrator. 
navigate to the Alert Manager. 

Alert > Define 

View > Query by example > Enter 

Table >%WF_ITEMS% 

View > Query by example > Run 

ADS Workflow Owner Assignment 

ADS Workflow User Key Assignment are displayed

Uncheck the Enable checkbox and save because these two alerts are not part of the 
business flow of Knowledge Management and should not be enabled. 
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How is Multi Lingual Support (MLS) used in Oracle Knowledge 
Management? 
When you create a solution in one language, a copy of the solution is created in 
other languages that you have installed. If you assign the publish status to any copy 
of the solution, then, the copy of the solution for other languages also gets 
published. 

Hence, you need to make sure that the solution is ready for all the installed 
languages before you put it in the publish state.

Can the search methods on the Advanced Search page be configured? 
Yes. The search methods on the Advanced Search can be configured. CS_KB_
SEARCH_TYPE_OPTIONS Lookup Type contains a list of lookup values that 
represent the different search methods. 

Why do I see the following warning even if I do not select any statement 
type or solution type while creating a solution: 
The statement types identified below are not compatible with the solution type you have 
selected. Click on the statement to modify its attributes.

All solutions and statements in Knowledge Management have to have a type. 
Solutions/statements without a solution type and statement type are considered as 
“not compatible”. 

You have to select a solution type and then click on the statement link to select a 
statement type and the warning will go away. 

Can I reference image files in a statement? 
It is not recommended to reference image file in the body of the statement.From this 
release, for security, any hard coded file ID access is not going to work. 

The regular attachment of a solution works. If you click the link in the attachment 
section, you can see the JPG. 

JMES patch requires all file IDs be encrypted before allowing the download. 

I have created a solution type but when I create a solution it does not 
appear on the solution type list? 
You must associate at least one statement type to your solution type. A solution 
type without an associated statement is incomplete and will not be available to 
select from the Solution Type list when a user creates a new solution.
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A
Oracle Knowledge Management Seed Data

A.1 User Role to Permission Mapping
Each type of a user in Oracle Knowledge Management System has a set of 
permissions. The following table summarizes Oracle Knowledge Management 
Roles to Permissions mapping.
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A.1.1  Knowledge Management Roles 
An Oracle Knowledge Administrator has all Knowledge Management specific 
permissions including all setup and other process oriented permissions. 

A Knowledge Worker is a user who creates/edits/technically reviews information 
in Oracle Knowledge Management. 

A Knowledge Management Agent is a user who interfaces with the customers 
directly (on the phone) or indirectly (online) to record their problems and provides 
them existing solutions or creates new solutions.

The following table lists role and permissions associated with a Knowledge 
Administrator, Knowledge Worker and a Knowledge Management Agent.

Table A–1 Knowledge Management Roles and Permissions

Permissions Description

CS_
SYSTEM
_ADMIN

CS_
KNOWLEDGE
_WORKER

CS_
SUPPORT
_AGENT

CS_Advanced_
Search

Knowledge: Search: 
Permission to view the 
Knowledge Management 
Advanced Search Screen 

YES YES YES

CS_Solution_View Knowledge: Search: 
Permission to view solution

YES YES YES

CS_Solution_View_
All

Viewing all solutions YES

CS_Solution_View_
Internal

Knowledge: search: 
Permission to View Public 
and Internal Solutions

YES YES YES

CS_Solution_View_
Public

Permission to view Public 
Solutions

YES

CS_Solution_View_
Restricted

Knowledge: Search: 
Permission to view 
Restricted Solutions

YES

CS_Solution_Create Knowledge: Authoring: 
Permission to create a 
solution

YES YES YES

CS_Assoc_Ext_
Obj_To_Sol 

Knowledge: Authoring: 
Permission to attach external 
objects to a solution

YES YES YES
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CS_Solution_
Update 

Knowledge: Authoring: 
Permission to Update a 
solution

YES YES YES

CS_Solution_Delete Knowledge: Authoring: 
Permission to delete a 
solution

YES YES YES

CS_Solution_View_
Internal 

Knowledge: search: 
Permission to view public 
and internal solutions

YES YES YES

CS_Solution_
Status_Update

Update Solution Status YES

CS_Solutions_
Comments_Add

Knowledge: Authoring: 
Permission to add solution 
comments

YES YES YES

CS_Solution_Get_
Lock

Knowledge: Authoring: 
Permission to get solution 
lock from user

YES

CS_Freq_Used_
Def_View 

Knowledge: Setup: 
Permission to view 
frequently used solution 
definitions

YES

CS_Freq_Used_
Sol_View

Knowledge: Search: 
Permission to view 
frequently used solutions

YES YES YES

CS_Freq_Used_
Def_Update 

Knowledge: setup: 
Permission to update 
frequently used solution 
definitions

YES

CS_Rec_Sol_View Knowledge: Setup: 
Permission to view 
Recommended Solutions

YES YES YES

CS_Rec_Sol_
Update

Knowledge: Setup: 
Permission to update 
Recommended Solutions

YES YES

Table A–1 Knowledge Management Roles and Permissions

Permissions Description

CS_
SYSTEM
_ADMIN

CS_
KNOWLEDGE
_WORKER

CS_
SUPPORT
_AGENT



User Role to Permission Mapping

A-4 Oracle Knowledge Management Implementation Guide                              

CS_Statement_
View 

Knowledge: Search: 
Permission to view 
statement

YES YES YES

CS_Statement_
Create 

Knowledge: Authoring: 
Permission to create a 
statement

YES YES YES

CS_Statement_
Delete 

Knowledge: Authoring: 
Permission to delete a 
statement

YES YES YES

CS_Statement_
Update 

Knowledge: Authoring: 
Permission to update a 
statement

YES YES YES

CS_Statement_
Global_Update

Knowledge: Authoring: 
Permission to update 
statements globally

YES

CS_Types_View Knowledge: Setup: 
Permission to view solution 
and statement types setup 
screens

YES

CS_Types_Edit Knowledge: Setup: 
Permission to edit solution 
and statement types

YES

CS_USED_
COUNT_UPDATE 

Knowledge: search: 
Permission to update 
solution used count

YES YES YES

CS_Personal_
Profile_Update

Knowledge: Other: 
Permission to Update 
Knowledge Management 
Personal Profile

YES YES YES

CS_Sol_Auth_
Profile_Update

Knowledge: Authoring: 
Permission to Update 
solution Authoring Profile

YES YES YES

CS_Workflow_
Setup_Update

Knowledge: Setup: 
Permission to update 
solution authoring workflow 
setup

YES

Table A–1 Knowledge Management Roles and Permissions

Permissions Description

CS_
SYSTEM
_ADMIN

CS_
KNOWLEDGE
_WORKER

CS_
SUPPORT
_AGENT
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CS_Worflow_
Setup_View

Knowledge: Setup: 
permission to view solution 
authoring workflow setup 
screens

YES

CS_Categories_
Update

Knowledge: Setup: 
Permission to update 
categories

YES

CS_Categories_
View

Knowledge: Setup: 
Permission to view 
categories

YES

Table A–1 Knowledge Management Roles and Permissions

Permissions Description

CS_
SYSTEM
_ADMIN

CS_
KNOWLEDGE
_WORKER

CS_
SUPPORT
_AGENT
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B
Profile Options

This appendix describes the profile options that are required for the successful 
implementation of Oracle Knowledge Management. Topics Include:

■ Section B.1, "Before You Begin"

■ Section B.2, "Overview of Setting Profile Options"

■ Section B.3, "Setting Profile Options"

■ Section B.4, "Oracle Knowledge Management Profile Options"
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B.1 Before You Begin
Before doing Oracle Applications Forms settings, ensure that all Oracle 
Applications server processes are up and running. In particular, if you stopped 
concurrent managers before applying Oracle Applications patchsets, restart them 
by changing to $COMMON_TOP/admin/scripts, and executing adcmctl.sh <APPS 
username/APPS password> start.

B.2 Overview of Setting Profile Options
As a System Administrator, you can use the System Profile Values window in 
Oracle Applications Forms to set up profile options for your user community. If you 
change a user profile option value, your change takes effect as soon as your users 
log on again or change responsibilities, and bounce the apache server. When you set 
up a user profile, you provide Oracle Applications with standard information (such 
as printer) that describes a user, responsibility, application, or site. You can set up 
values for user profile options at each of the following profile levels.

■ Site: Option settings pertain to all users at an installation site.

■ Application: Option settings pertain to all users of any responsibility associated 
with the application.

■ Responsibility: Option settings pertain to all users currently signed on under 
the responsibility.

■ User: Option settings pertain to an individual user, identified by their 
application username.

The values you set up at each level provide run–time values for each user’s profile 
options. An option’s run–time value becomes the highest level setting for that 
option.

When a profile option may be set at more than one level, site has the lowest priority, 
superseded by application, then responsibility, with user having the highest 
priority. For example, a value entered at the site level may be overridden by values 
entered at any other level. A value entered at the user level has the highest priority, 
and overrides values entered at any other level.

For example, for a given user, assume the printer option is set only at the site and 
responsibility levels. When the user logs on, the printer option assumes the value 
set at the responsibility level, since it is the highest–level setting for that option.
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The options specified at the site–level work as defaults until the same options are 
specified at other levels. Application users may use the Personal Profile Values 
window to set their own personal profile options at the user level. Not all profile 
options are visible to users, and some profile options, while visible, may not be 
updated by end users. For more information about profile options, See Oracle 
Applications System Administrator’s Guide Release 11i.

B.3 Setting Profile Options
Use the following procedure to set up any profile option.

Steps
1. Log on to Oracle Applications Forms with the System Administrator 

responsibility. 

2. Go to Profile > System. The Find System Profile Values window opens. 

3. Check the level(s) at which you want to set the profile option. The available 
levels are listed below: 

■  Site

■ Application— If you select this level, choose the application from the 
Application LOV for which you want to set the profile option.

■ Responsibility— If you select this level, choose the responsibility from the 
Responsibility LOV for which you want to set the profile option.

■ User— If you select this level, choose the user from the User LOV for whom 
you want to set the profile option.

4. In the Profile field, enter the profile name, such as Knowledge: Active 
Knowledge Base System, or a wildcard search criterion such as Knowledge%.

5. Click Find. The System Profile Values form opens with the results of your search.

6. Verify or set the profile option(s) at the levels that you selected.

Note:  As a System Administrator, you should set site level option 
values before specifying profile options at the other three levels 
after the installation of Oracle Applications.
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B.4 Oracle Knowledge Management Profile Options
The following table lists the Profile Options available in Oracle Knowledge 
Management in this release.

Table B–1 Profile Options for Oracle Knowledge Management

User_Profile_Option_
Name Description

Default Profile 
Value

Knowledge: Action for 
Negative Solution 
Feedback

Determines what action to be taken for 
Solutions that are linked in a negative status 

NA

Knowledge: Action for 
Positive Solution 
Feedback

Determines what action to be taken for 
Solutions that are linked in a positive status

NA

Knowledge: Available 
Repositories for Search

Sets the available repositories for the Basic 
Search to search across.

SOLUTIONS, 
FORUMS

Knowledge: Concurrent 
Search Mode for Unified 
Search

Sets Basic Search to search all repositories 
concurrently if set to Yes. 

Recommended that this profile is set to ’Yes’

Yes

Knowledge: Default 
Authoring Flow

Sets the default authoring flow to which 
solutions will be submitted.

No default value

Knowledge: Default 
Distribution Level

Sets the default statement visibility level for 
statement authoring

Internal

Knowledge: Default 
Product Category Set

Replaces the profile option Knowledge: 
Default Knowledge Base Product Category 
Set

Determines the Product Category set used 
from Inventory.

Inv.Items

Knowledge: Default 
Search Relevancy

Filters search results below this score, 
applies to the simple and advanced search

List of values includes 1, 10, 20, 30, 40, 50, 
60, 70, 80, 90, 100

1
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Knowledge: Default 
Searching Method

Sets the default searching method in the 
simple and Advanced solution search.

Searching methods include:

Accumulate, All Keywords, Any Keywords, 
Intermedia, Fuzzy match, Reference 
Number, Theme

Note: The Administrator should not use the 
value Reference Number as the default 
search method.

Accumulate

Knowledge: Default 
Solution Type for 
Authoring

Sets the default solution type used in 
Solution authoring

Symptom Cause 
Action

Knowledge: Display 
Platform Attributes

Hides platform attributes across Oracle 
Knowledge Management. The platform 
attribute will be hidden from the search 
pages as well as detail pages.

Yes

Knowledge: Display 
QuickFind

Controls whether the Quick Find bar is 
displayed in Oracle Knowledge 
Management.

No

Knowledge: Display 
Search Option List

Controls whether the ’Using’ search option 
is displayed or not on the Solution 
Advanced Search

No

Knowledge: Event 
handler class name for a 
calling application

Replaces the profile option Knowledge: 
Event Handler class name for KM 
solved/unsolved actions predefined by 
other apps

Same values and functions apply. The 
profile option has only been renamed.

Used in the integrations with calling 
applications. Defines the event name 
between the solution and calling object. The 
default event will link the solution to the 
calling application object

Oracle.Apps.CS.
Knowledge.Bean
.DefaultKMEven
tHandler

Knowledge: Expose 
Search Related Solutions 
Button

Controls whether the Search Related 
Statements button is displayed or not on the 
Advanced Solution Search.

No

Table B–1 Profile Options for Oracle Knowledge Management

User_Profile_Option_
Name Description

Default Profile 
Value
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Knowledge: Maximum 
Number of Search 
Results

Replaces the profile option Knowledge: 
Knowledge Base Search: Maximum 
Number of Search Results.

Same values and functions apply. The 
profile option has only been renamed.

The maximum number of search results to 
display in search result

100

Knowledge: Select 
Authoring Flow

Controls whether user can select an 
authoring flow to submit the solution to 
during the solution authoring process.

If this value is set to No: User will not be 
able to pick a flow, and all submissions are 
sent to the default flow defined in profile 
option Knowledge: Default Authoring Flow

Yes

Knowledge: Statement 
Display Order on 
Solutions Details Page

Controls the display of statements by the 
order in which they were created or 
grouped by statement type

Position Order

Knowledge: User 
Responsibility when 
Calling KM from 
Another Application

Replaces the profile option Knowledge: 
Knowledge Base Responsibility when 
Called from Another Application

Same values and functions apply. The 
profile option has only been renamed.

The user responsibility when arriving at 
KM from calling application.

Knowledge 
Agent-Oracle 
Service

Table B–1 Profile Options for Oracle Knowledge Management

User_Profile_Option_
Name Description

Default Profile 
Value



                                                            Knowledge Management Lookup Types and Lookup Codes C-1

C
Knowledge Management Lookup Types and

Lookup Codes

This appendix describes how to add Lookup Codes to Lookup Types in Oracle 
Applications Forms.

C.1 Viewing Lookup Types for Knowledge Management

Responsibility
Customer Support responsibility

Login
Log in to Oracle Applications Forms.

Steps
1. Log in to Oracle Applications Forms as a system administrator. Responsibilities 

form appears.

2. Switch responsibility to the Customer Support responsibility.

3. Select Others > Service: Lookup. Oracle Service Lookups Form appears.

4. From the View menu, select Find. Lookup Types pop-up window appears. 

5. Enter CS_KB in the Find field. Select OK.

C.2 Configuring the Solution Authoring Flow Status
CS_KB_STATUS lookup type is a fully customizable lookup type for Knowledge 
Management. Use the following procedure to add lookup codes to this lookup type.
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Responsibility
Customer Support responsibility

Login
Log in to Oracle Applications Forms.

Steps
1. Log in to Oracle Applications Forms as a system administrator. Responsibilities 

form appears.

2. Switch responsibility to the Customer Support responsibility.

3. Select Others > Service: Lookup. Oracle Service Lookups Form appears.

4. From the View menu, select Find. Lookup Types pop-up window appears. 
Enter CS_KB_STATUS.

5. Search results showing a list of steps for solution authoring flows appear. You 
can select the steps that you want to enable by checking the check boxes in the 
Enabled column.

6. Select Save from the File menu.

C.3 Configuring the Search Method
The search methods in Basic and Advanced Search screens can be configured. CS_
KB_SEARCH_TYPE_OPTIONS is the lookup that contains a list of lookup values 
that represent the different search options. Administrators can enable/disable the 
search values in this lookup and also rename the search options to be available in 
the Basic and Advanced Search screens. Atleast one search method has to be 
enabled.

Responsibility
Customer Support responsibility

Login
Log in to Oracle Applications Forms.

Steps
1. Log in to Oracle Applications Forms as a system administrator. Responsibilities 

form appears.
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2. Switch responsibility to the Customer Support responsibility.

3. Select Others >Service >Lookup. Oracle Service Lookups Form appears.

4. From the View menu, select Find. Lookup Types pop-up window appears. 
Enter CS_KB_SEARCH_TYPE_OPTIONS. 

5. Search results showing a list of search options appear. Check the check boxes in 
the Enabled column to enable the selected options.

6. Select Save from the File menu.
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D
Sample File For Knowledge Management

Solution Import Program

D.1 Example of a Solution File for the Solution Import Program 
Knowledge Management Solution Import Program uses the input xml file name 
(absolute path) and commit interval (time intervals for committing the import) 
parameters for running. The File has to contain the solutions in a XML format and 
have to be compliant with the Document Type Definition (DTD) for Knowledge 
Management, cskb_solution.dtd. This program checks the validity of the input xml 
document. If it is valid, the solutions are created, one after the other. If any data is 
invalid, the solutions are not created. If processing for a solution fails, its changes 
are rolled back, and a log error message is written and the next solution in the file is 
imported. Each new solution to be uploaded can either have a Saved status, or it 
can be directly published, if the flow information is provided. Only published 
solutions can be updated, and have a published status after update. Attachments 
and external links are not supported but Statement Global Update is supported. 
Any statement with a statement number is globally updated according to the new 
data specified in the XML document.

<?xml version="1.0"?>
<!DOCTYPE solution_list SYSTEM "cskb_solution.dtd">
<solution_list>
  <solution>
    <solution_type> Symptom Cause Action</solution_type>
    <solution_distribution>External </solution_distribution>
    <title>Maria's Test Solution 1 (mchui061902b)</title>
    <category>Home&gt;12 World Cup&gt;United States</category>
    <product>Passport Backup Drive</product>
    <product>Windows NT (wrong)</product>
    <platform>Sentinel Standard Desktop</platform>
    <statement>
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      <statement_type>Symptom</statement_type>
      <statement_distribution>External</statement_distribution>
      <content_type>HTML with AutoLink</content_type>
      <summary>mchui061902b - symptom 1</summary>
      <detail></detail>
    </statement>
    <statement_links>
      <statement_no>10386</statement_no>
      <statement_no>34</statement_no>
      <statement_no>10650</statement_no>
    </statement_links>
  </solution>
  <solution>
    <flow>
      <flow_name>Bayu Flow</flow_name>
      <step>Public</step>
    </flow>
    <solution_type> Symptom Cause Action</solution_type>
    <solution_distribution>External </solution_distribution>
    <title>Maria's Test Solution 2 (mchui061902c)</title>
    <category>Home&gt;New Category&gt;New Category 2</category>
    <product>Windows NT</product>
    <product>Windows NT</product>
    <platform>windOWS 95</platform>
    <statement>
      <statement_type>Symptom</statement_type>
      <statement_distribution>External</statement_distribution>
      <content_type>Text with AutoLinks</content_type>
      <summary>mchui061902c - symptom 1</summary>
      <detail>another imported statement - published</detail>
    </statement>
    <statement_links>
      <statement_no>10387</statement_no>
    </statement_links>
    <statement_link_update>
      <statement_no_upd>10386</statement_no_upd>
      <statement_type_upd>Symptom</statement_type_upd>
      <statement_distribution_upd>Internal</statement_distribution_upd>
      <content_type_upd>HTML</content_type_upd>
      <summary_upd>update existing statement summary</summary_upd>
      <detail_upd>global update of statement CLOB</detail_upd>
    </statement_link_update>
  </solution>
  <solution>
    <solution_number>10419</solution_number>
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    <solution_type> Symptom Cause Action</solution_type>
    <solution_distribution>Limited</solution_distribution>
    <title>UPDATED Solution 1000003 yes (updated on 062102)</title>
    <category>Home&gt;New Category&gt;New Category 2</category>
    <product>Windows NT</product>
    <platform>windOWS 95</platform>
    <statement>
      <statement_type>Symptom</statement_type>
      <statement_distribution>External</statement_distribution>
      <content_type>Text</content_type>
      <summary>create new statement </summary>
      <detail>new statement details</detail>
    </statement>
    <statement_link_update>
      <statement_no_upd>10386</statement_no_upd>
      <statement_type_upd>Symptom</statement_type_upd>
      <statement_distribution_upd>External</statement_distribution_upd>
      <content_type_upd>Text with AutoLinks</content_type_upd>
      <summary_upd>global update of statement</summary_upd>
      <detail_upd>statement detail should be globally
updated</detail_upd>
    </statement_link_update>
  </solution>
</solution_list>
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Glossary

Action

An Oracle’s Knowledge Management (Knowledge Management) statement type 
that contains the solution to an issue. It is a part of the Symptom/Cause/Action 
solution type.

Accumulate

This search finds documents that contain at least one of the query terms.

Advanced Search

Advanced Search is a more comprehensive search than Basic Search. You can search 
for solutions under different categories, products, and/or platforms. You can search 
one solution type or all, and search for statements. You can also select an existing 
statement in Knowledge Management and perform a related search.

All Keywords

This search uses the AND operator. The search results must match all terms in the 
query.

Any Keywords

This search uses the OR operator. This search can match one or more query terms. 

Attachment

A link from a solution to a supporting item of information that enhances the value 
of the solution for its users. Attachments can include graphics, scripts, or 
documents in different file formats.
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Authoring Flow

An Authoring Flow defines the steps or tasks that a solution has to follow in the 
solution approval or rejection process.

Basic Search (Also known as a Unified Search)

Basic search is a type of search that allows you to search for a solution, solution 
category, and forum message based on a keyword.

Boolean

In this searching method, you can enter your own Oracle Text operators. If you do 
not enter an operator, this search performs a phrase search.

Category

A folder containing a set of related solutions.

Cause

A Knowledge Management statement type that contains the reason for the solution 
issue. It is a part of the Symptom/Cause/Action solution type.

Dynamic Linking

Is the process of linking an object type or a unique identifier within a statement as a 
link to additional information related to that object type or to that unique identifier.

End Date

End dating a statement or solution type will prevent any further statements or 
solutions of this type from being created. Solutions or statements currently in 
progress will be allowed to complete. 

End dating a solution or statement type does not mean that the solution or 
statement type has been deleted. Instead, it is considered a “soft” delete that can be 
revoked by removing the end date on the solution or statement type at any point in 
time

Find Related Statements

The search method that finds all other statements that have been previously linked. 
The results are displayed based on the strength/weight of the link. 

Find Similar Statements

A text search that finds matches that are determined by comparing keywords to the 
summary of the statements in the repository.
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Fuzzy

In this searching method, the query keywords are expanded into a set of similarly 
spelled keywords, before a search is performed. This search is helpful if there are 
frequent misspellings of the query keyword in the repository. This search will find 
incorrect spellings and synonym matches to the query terms.

Knowledge Base

The Knowledge Management database that contains information that can be used 
to solve issues.

Knowledge Worker

An individual that creates/edits/technically reviews information within 
Knowledge Management.

Merchant

A company that has purchased or is using one or more Oracle applications.

Oracle Text

Oracle Text is a feature that enables the Oracle database to store, manage, and 
retrieve text, documents, geographic location information, images, audio, and video 
in an integrated fashion with other enterprise information. 

Formerly known as Intermedia Text.

Relationship

A link between a solution to a statement or a statement to another statement that 
indicates they have been used together at some time as part of a solution. A 
statement can have many relationships based on the number of solutions of which it 
is a part.

Score

Each solution is scored based on the text match performed by Oracle Text and the 
number of times it has been successfully used to solve issues. These scores are 
shown as a combined score to indicate the strength of the match to the query 
entered. The maximum score is 100. 

Solution

Collection of information or statements to solve an issue or answer a question. 
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Solution Number

Every solution in Oracle’s Knowledge Management is associated with a unique 
number. This search will find the solution that is associated with the number 
entered in the search query field. 

Solution Score

Each solution is scored based on the text match performed by Oracle Text and the 
number of times it has been successfully used to solve issues. These scores are 
shown as a combined score to indicate the strength of the match to the query 
entered. The maximum score is 100. 

Solution Type

An attribute of a solution that helps define the type of content that goes into a 
solution (a solution type is like a template). 

Statement

A statement is a description of any aspect of a problem, its cause, or its resolution. It 
contains a summary field that can be a maximum of 500 characters and a detail field 
that can be maximum of 4 GB. Statements can be segmented into statement types.

Note: If the detail field is greater than 32KB, the detail field displays as read only 
and cannot be edited. Users need to use statement import/export to edit the 
statements that are bigger than 32k. Statement import only supports text file. 

Statement Type

Statements can be segmented into statement types. It is an identifying name 
associated with a particular part of a solution type. For example, question is a 
statement type in a question/answer solution type.

Status

Solutions and statements have a status attribute. This attribute describes the phase 
of review that a solution or statement has gone through. Common solution statuses 
are: Draft, Under Edit, Technical Review, Editorial Review, Obsolete, and Published.

Symptom

A Knowledge Management statement type that contains the issue the user is trying 
to solve. It is a part of the Symptom/Cause/Action solution type.
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Theme

This search is also called an about search in Oracle Text. Oracle Text categorizes the 
documents in its repository into themes, based on their textual content. When this 
search is performed, the query keywords are compared with the theme index. 
Documents having the same themes as the keywords appear in the result list.

Unified Search

Also known as a Basic Search. Please see Basic Search definition.

User

A Knowledge Management user can be an internal or an external user. External 
users are users that can see published solutions. Internal users include system 
administrators, knowledge workers, and knowledge agents. 
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